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Foreword
Thank you for using FACut Plane Bevel Cutting Control Software!

BOCHU FACut Plane Bevel Cutting Control Software (hereinafter referred to as FACut) is a

dedicated control software for plane bevel laser cutting, featuring high precision and high efficiency. The

main functions include Vision Calibration, Swing Correction, Custom PLC, parameter settings,

simulation, and accurate control for laser cutting.

FACut must be used with the HypTronic3 CNC host to perform actual cutting operations. When

running on a computer other than the HypTronic3 CNC host, it will enter demo mode.

Please note that this user manual is only used as the operation instruction of the main program of

FACut software. Please refer to other manuals or contact us for other tools and software installed with

FACut software.

This manual is based on FACut version 1.13.2406.2. We apologize for the fact that the FACut you

are using may differ in some respects from what is stated in this manual due to the continuous updating of

software functions. Contents of this manual are subject to change without prior notice.

Some of the independent feature descriptions linked are currently only available in Chinese. English

versions are being progressively developed and will be updated in due course. If you require immediate

access to specific documentation, please contact technical support.

For any questions or suggestions during usage, please contact us through the information provided.

Convention Symbol Explanation

Notice: Supplementary or explanatory information for the use of this product.

Caution: If not operated as specified, it may result in minor physical injury or equipment damage.

Warning: If not operated as specified, it may lead to death or serious physical injury.

Danger: If not operated as specified, it will cause death or serious physical injury.

Safety Statement

The machine tool operation and laser cutting quality have something to do with the material being

cut, the laser used, the gas used, the pressure and the parameters you set. Please set the parameters
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according to your cutting process requirements!

Improper parameter setting and operation may lead to poor cutting effects, damage to the cutting

head or other machine components, and even personal injury. FACut-H has tried its best to provide

various protection measures. Laser equipment manufacturers and end users are supposed to abide by

operating procedures to avoid injury accidents as possible as they can.

The company shall not be held responsible for any direct, indirect, incidental, and/or consequential

losses or liabilities resulting from improper use of this user manual or the product.



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com

Revision History
Version No. Date Description

V1.0.0 2023/10/18 The first English edition for FACut 1.6.2210.1.

V1.1.0 2025/06/30 Updated to BOCHU’s latest documentation templates.

Updated according to the feature set of FACut

1.13.2406.2.
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Chapter 1 Quick Start

1.1 Feature Highlights

 Supports importing 2D drawings in formats such as *.slp, *.lxds, *.nrp2, *.lxd, *.dxf, *.g, *.nc, *.gen,

*.txt, and *.dwg.

 Automatically optimizes imported files (e.g., *.dxf), including Delete Duplicates, Join Nearest

Lines, Delete Invisible, Automatic Identify Inner/Outer Contour, etc.

 Supports various bevel types such as V, Y, X, and K. After importing drawings by outer contour and

confirming plate thickness, the bevel property can be flexibly configured for each part.

 Establishes a 3D mathematical model for the rotary mechanism and applies advanced algorithms.

With a vision sampling device, the system performs high-precision sampling and analysis to reduce

machining errors caused by structural accuracy or installation deviations.

 Provides compensation mechanisms for plate deformation by performing pre-sampling to quantify

deformation, ensuring machining accuracy across various materials and conditions.

 Supports normal vector following to eliminate dimensional deviations caused by different nozzles

and cutting angles.

 Supports local editing and optimization of drawings to improve production efficiency.

 Offers built-in automatic nesting and co-edge bevel cutting for bevel applications.

 Supports Auto Split and Manual Break that allows flexible part property editing without altering the

original drawing geometry.

 Supports both vertical and tilted piercing modes.

 Supports the editing of technique marks, allowing detailed control of special processing scenarios

such as corners.

 Supports the editing of power curves and setting related parameters such as smooth start, smooth end,

corner swing, etc.

 Offers two corner motion strategies: Direct Corner Transition and Normal-based Optimization,

balancing cutting stability and quality.
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 Supports high-speed capacitive edge finding.

 Provides breakpoint memory for forward and backward tracing.

 Allows positioning to any point during stop or pause, and supports resuming processing from an

arbitrary location.

 Enhanced PLC editing capabilities, supporting script-based logic and process control.

 Programmable I/O ports with configurable alarm and pre-alarm inputs.

1.2 Acquire and Install

FACut is pre-installed in HypTronic3 by default and can be used directly upon startup.

The HypTronic host PC supports one-click system restore, allowing for quick reset to factory default

settings in case of system issues.

You can also contact the supplier or technical support for the system install package. It will be much

more convenient for subsequent upgrades and restoration.
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1.3 Quick Start

In this section, you’ll see how a debugged machine works normally with FACut.

Before processing, make sure the system has completed operations including Return Origin,

Capacitance Calibration, Vision Calibration, and Swing Correction. Ensure that the A/B axes are

properly calibrated without significant offset. If not, perform the necessary initial setup steps such as

Return Origin and other calibrations.

Figure 1-1 Interface overview

Figure 1-2 Interface overview (continued)

Before starting the operation, it is recommended that you familiarize yourself with the software

interface. In the figures above, each region is marked with a yellow box and labeled with a number for

reference.

 Area 1: Drawing Toolbar

Starting from version 2024C, FACut separates the toolbar into two sections: Drawing and

Production. The drawing toolbar contains nine major functional zones: View, Geometry, Technique,

Draw, Extend, Bevel, Tools, Align and Order, and Sequencing. Detailed functions will be covered

in later chapters.
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 Area 2: Left-side Drawing Tools

This toolbar provides a comprehensive set of drawing tools, including Explode, Clip, Technique

Mark, and Dished Head, among others.

 Area 3: Technique Settings Panel

After selecting a specific path, click on the colored squares to assign different layers. Click the

Technique button at the top for advanced technique parameter settings.

 Area 4:Parameter Settings Panel

This section allows for parameter adjustments such as burst settings and jog settings. You can open

or hide it by clicking the Settings button in the top-left corner of Area 5.

 Area 5: Processing Control Panel

This area enables operations such as turning the Shutter and Aiming on/off, jogging or stepping the

cutting head, performing Frame, Dry Run, Simulate, Lift Up, etc. You can Start machining from

this panel.

 Area 6: Log &Alarm Panel

Every operation and machine change is displayed here. The log helps identify the reasons for any

failures and can be exported to technical support for troubleshooting.

 Area 7: Status Monitoring Panel

Click the gear-shaped icon in the lower-right corner of this section to adjust the five modules

displayed on the interface, making it easier to monitor machine movement and processing

conditions.

 Area 8: CAD View

The main drawing is displayed here. When a shape is selected, its bevel properties are shown in the

top-left corner of this area. Click the telescope icon in the bottom right for a 3D preview. This area

also supports Locate Toolpath, Rotate, and Fine Tune at the bottom.

 Area 9: Production Toolbar

As shown in Figure 1-2, this panel includes sections such as File, Machine Tool, Set, Auxiliary, and

Tools. If the secondary bevel function is enabled in FAConfig, the related settings will also appear

here.
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1.3.1 Processing Flow

Figure 1-3 FACut simple processing flow

1.3.2 Import Drawings

Click File→ Open File, you can choose Open File, Import DXF, or Import SLP. After selecting an

option, a file selection dialog will appear. The right panel of the dialog provides a preview of the

machining geometry and its dimensions.

Figure 1-4 Import drawings

Figure 1-5 Drawing selection and preview
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1.3.3 Plate Property and Bevel Property

Click Plate Property and Bevel Property to set relevant parameters.

Figure 1-6 Plate Property and Bevel Property

Figure 1-7 Edit Plate Property

Figure 1-8 Set Bevel Property

After adding bevels, select the part and click the telescope icon in the lower right corner of the CAD

view to preview the 3D model of the beveled part.

During preview:

 Hold and drag the left mouse button to pan the model.

 Scroll the mouse wheel to zoom in or out.
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 Hold and drag the mouse wheel to rotate the model.

 Click anywhere in the drawing area to exit preview mode.

Figure 1-9 3D model preview

Notice: This preview is available for individual parts only.
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1.3.4 Technique Layers

Select a part or toolpath and use the technique setting panel on the right to assign the appropriate

layer. For compound bevels, you can either assign multiple toolpaths on a single layer or one toolpath per

layer.

Figure 1-10 Technique layer setting

In Technique setting, you can either directly import parameters from the technique library or

configure specific technique parameters for piercing, cutting, etc.

Figure 1-11 Read from technique library

Notice: In FACut, technique library parameters are stored based on Toolpath, not Layer.
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1.3.5 Auxiliary Functions

The following list describes the auxiliary functions needed before and after actual cutting:

 Capacitive Find Edge: Before cutting, the system locates the edge of the plate to determine its tilt and

adjusts the orientation of the geometry accordingly. This ensures parallel alignment between the part

and the plate, improving material utilization and reducing the need for manual alignment.

 Capacitance Calibration: When following fails, an alarm is triggered, or the nozzle is replaced, the

Capacitance Calibration module allows quick one-click calibration on the designated calibration

plate.

 Detect Cutting: For bevel toolpaths, the system runs the toolpath once in following mode at a preset

speed to collect data and compensate for plate deformation. If Realtime Plate Detection is enabled in

global settings, this pre-run step can be skipped when processing fixed-pose bevel toolpaths.

1.3.6 Zero Point

Use the top-right area of the processing control panel to configure the Floating Coordinate System

or Workpiece Coordinate System. You can also use the drop-down menu next to Return Zero to access

previously used zero points.

Figure 1-12 Processing control panel
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1.3.7 Machining

Before machining, please confirm that the equipment is normal without alarm, and the drawings,

techniques, zero points and auxiliary functions to be processed are correct. Also, you can reconfirm

whether the drawings are within the boundary of the plate through Frame, and observe the cutting

sequence by Simulate.

If there is obvious inclination of the whole plate or the area to be processed, you can enable Detect

Cutting in Global Parameter, and then click Start in the processing control panel to start processing.
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Chapter 2 Graphic Operations

2.1 Viewing Graphics

2.1.1 Drawing File

FACut supports operations such as Open File, New, Save, and Save As for drawing files. It also

supports importing *.dxf and *.slp files. Additionally, the File drop-down menu provides quick access to

recently opened files.

Figure 2-1 File

 Open File: Replaces the current file with the selected one and opens it directly.

 Import File: The imported drawing appears in a floating state following the cursor. Its reference point

aligns with the preset snapping point in the software. Click anywhere in the interface to place the

drawing into the current file without affecting existing content.

Figure 2-2 Import file - floating state

Figure 2-3 Import file - completed
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2.1.2 Selecting Graphics

FACut provides various operations for selecting graphics. The most basic is click selection, where

single clicking a shape selects it directly. A more common method is box selection, where dragging the

mouse forms a semi-transparent box to select shapes.

There are two types of box selection:

 Left to right drag: Displays a solid blue rectangle. Only graphics fully enclosed in the rectangle will

be selected.

 Right to left drag: Displays a dashed cyan rectangle. Any graphic that is partially or fully enclosed

will be selected.

The diagram below illustrates both methods. In the left image (left to right), only B and C are

selected. In the right image (right to left), A, B, C, and D are all selected. Flexible use of these two

methods can improve selection efficiency. Flexible use of these two methods can improve selection

efficiency.

Figure 2-4 Box Selection Illustration

Regardless of whether click selection or box selection is used, holding the Shift key while selecting

allows you to add new graphics without deselecting the current ones.

Figure 2-5 Select
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In addition to the basic operations above, FACut also provides advanced selection options under

Drawing→ View→ Select, including:

 Basic Operations: Enable All, Invert Selection, Copy, Paste, Cut, Delete, Deselect, and Copy with

Basepoint.

 Deselect: Can also be done by clicking on a blank area of the drawing.

 Copy with Basepoint: Allows you to define a reference point. When pasting, the shape will

maintain the same relative position to the mouse as the basepoint has to the original geometry.

 Graphic Operations: Select Open Contour, Select Similar Contour, Select All Outer/Inner Contour,

Select Contour Length Smaller than Specified, and Select by Type.

 Select Similar Contour: Supports filtering by layer or angle and selects all shapes that match the

criteria.

 Select by Type: Allows selecting all polylines, circles, or Bezier curves.

 Layer Operations: Select Layer and Lock Layer.

 Select Layer: Selects all graphics on the same layer.

 Lock Layer: The background layer is locked by default. You can also lock marking or other

layers as needed. Locked layers cannot be selected.

 Disable Fast Drag-Copy: Disables the operations such as drag, copy, or rotate the graphics. This will

prevent the malposition of nested graphics.

 Unified Select Compound Bevel Toolpaths: For compound bevels, selecting one toolpath

automatically selects all associated toolpaths.
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 Batch Modify: Select a single graphic and click Batch Modify in the Select drop-down menu to open

the Batch Modify window, where the modifications made to the very graphic will be applied to other

similar ones. Supported operations include geometric transformation, applying part techniques,

setting cutting techniques, beveling, sequencing, etc. Assigning layers and applying modifications to

all nesting results are also supported.

Figure 2-6 Batch Modify
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2.1.3 Displaying Graphics

FACut offers a variety of display options under Drawing→ View→ Display.

Figure 2-7 Display drop-down menu

Display features include:

 Display Bevel Lower Surface Path: Displays the bottom bevel paths as solid white lines.

 Display Bevel Information:

 Display Bevel Type: For example, X bevel is shown in yellow text for X bevels.

 Display Bevel Parameters: For example, X top 15° bottom 30° indicates bevel type and angles

in yellow text.

Figure 2-8 Bevel Display

 Custom Bevel Parameters: Opens the Custom Bevel Parameters Display window where you

can define what information to show for each bevel type. Refer to the Parameter List and
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preview diagrams to configure the Custom Information.

Figure 2-9 Custom bevel parameters display

 Display Part Number: Displays one serial number for each group if graphics are grouped.

 Display Contour Number: Displays a unique number for each shape within a group.

 Display Start Point: Displays as small white circles.

 Display Cutting Path: Displays as green arrows.

 Display Travel Path: Displays as yellow dashed arrows.

 Display MicroJoint Tag: Displays as small white box outlines, indicating where the path is

intentionally interrupted.
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2.2 User Settings

FACut allows configuring automatic optimization and drawing board parameters according to their

personal usage habits.

When Auto Optimize settings are enabled, imported *.dxf and other external files will be

automatically optimized based on the configured settings, including: Delete Invisible, Delete Duplicates,

Join Nearest Lines, and Auto Smooth. Auto Sort, Import Unit, and Layer Mapping are also supported.

Notice: If Auto map layers in DXF file is not enabled, graphics imported with default layer

settings will be automatically assigned to Layer 10.

Configuring Drawing parameters helps improve drawing efficiency. For example, FACut provides

various auto attach features during drawing, such as attach to grid points, key points of graphics, or

graphic boundaries. You can also enable Object Capture, and the Capture Distance can also be defined.

You can also adjust Universal, Nest, Report, and other settings based on Using Habit, including

settings such as remembering Find Edge Settings, toolpath deformation and overlap checks.

When importing *.gen or *.nc0 files, you can also define parameters for Layer Mapping, Auto

Compensate, and Drawing Rotation.

Figure 2-10 User settings
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2.3 Geometry

2.3.1 Size

FACut offers seven quick dimension adjustment tools and supports dynamic zooming with specified

base and reference length, accessible via the Size drop-down menu. Click Size or Modify Size in the

drop-down menu to adjust the dimensions of the selected graphics.

Figure 2-11 Modify size

When the lock icon appears as shown below, the width and height are scaled proportionally based on

the original aspect ratio.

Figure 2-12 Lock uniform transformation

To set width and height independently, click the icon to unlock the proportions.

Figure 2-13 Unlock uniform transformation

Scale Center defines the alignment between the new and original graphics. For example, Top-Left

indicate the graph in new scale at the top left of the original one.

Notice: Non-uniform transformation of bevel graphics is prohibited in FACut, as it may cause

toolpath errors after bevel properties are set.



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 19

2.3.2 Geometry

Transform provides rich geometric transformation tools such as Translate, Flip, Rotate etc.

To use a transformation:

Step 1 Select the desired geometry.

Step 2 Choose the corresponding function in the Transform drop-down.

Step 3 Follow the prompts in the log & alarm panel.

Figure 2-14 Geometry

Locate at the bottom-right corner of the CAD panel:

 Locate Toolpath: Enter a toolpath number to zoom into and locate the corresponding path directly.

 Rotate: After inputting a desired angle, select the geometry and press A/D to rotate

counterclockwise/clockwise by the specified angle, orW/S to rotate in 90° increments.

 Fine Tune: Enable the checkbox next to Fine Tune, enter a distance, select the geometry, and use

arrow keys to move the graphic incrementally. Hold Ctrl + arrow keys to duplicate the selected

geometry at the specified distance.
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2.4 Drawing Graphics

2.4.1 Basic Drawing Tools

The quick-access toolbar on the left supports common shapes like isolated points, polylines, circle

(full circle, three-point arc, sweep arc, and elliptical arc), and polygon (rectangle, rounded rectangle,

polygon, and star). The top drawing toolbar provides more options including: circle (with option to

Replace Circle with Dot), standard part, rectangle (including obround and rounded rectangle, text,

polyline (including polygon and star), and isolated point.

2.4.2 Text

FACut supports both text insertion and curve conversion: Click the text icon in the toolbar, then click

on the CAD panel to insert text. The text will be selected automatically.

Figure 2-15 Text

When text is selected, the Text tab appears, where content, font, size, and style can be adjusted. As

shown in the figure below:

Figure 2-16 Text parameter settings

Click Convert to curve, and you will see:

 Converts the text to vector shapes, making it independent from font files. Ensures consistent

appearance across devices, even if the font is not installed.

 Prevents accidental changes to font, size, or style, preserving design integrity.
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2.4.3 Standard Parts

FACut supports quick drawing of standard parts. Click the Standard Parts icon to open the standard

parts library.

Figure 2-17 Standard parts

Figure 2-18 Standard parts library

Select the part shape then set the parameters. After selecting a part type, set the corresponding

parameters in the secondary panel.

Figure 2-19 Standard parts parameter settings
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2.4.4 Measure

FACut provides measuring tools for measuring the distance between two points.

Figure 2-20 Measure icon

Click the measure icon and select a point on the drawing board then click another point, the log

panel will show a position message between these 2 points.

Figure 2-21 Measure

Right-click or press ESC to exit the measuring status.

2.4.5 Graphic Optimize

Imported graphics are automatically optimized by FACut. The behavior is defined in User Settings

→ Auto Optimization.

Figure 2-22 User settings

For manual optimization, use Graphic Optimize in the toolbar. Supported operations include Join

Nearest Lines and Delete Invisible.

Figure 2-23 Graphic optimize

Notice: Graphic optimization applies to base drawings only and is different from Split.
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2.4.6 Align

FACut allows quick alignment of graphics. Select the target geometry, choose a desired alignment

method from the Align drop-down, and multiple objects can be aligned simultaneously.

Figure 2-24 Align

2.4.7 Dished Head

FACut supports hole processing on dished (non-planar) surfaces, including head vertical holes,

normal holes, and projection normal holes. Currently, this function requires a pre-drawn 2D top-view

drawing.

Select the geometry where a dished head hole needs to be configured. Click Dished Head at the

bottom of the left toolbar to enter the dished head editing interface. Guide elements such as longitude,

latitude, and annotations will be automatically identified as non-cutting layers. Click Clear Mark to

remove these auxiliary elements.

Figure 2-25 Dished head editing
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Select the desired closed curve to be defined as a dished head hole. Click Dished Head Hole. In the

popup window, refer to the diagram and drawing labels to select the hole type, hole phase angle, and the

spherical section angle. Click OK, and a hole label will appear next to the corresponding curve in the

editing window.

Figure 2-26 Dished Head Hole

If Batch edit the spherical section angle of dished head at the same latitude is checked, all circles

located along the same latitude line will automatically share the same spherical section angle—saving

repetitive operations.

Notice:

1. When setting normal holes, the 2D top-view must be replaced with a normal-view drawing.

2. If the dished surface is planar, projection normal hole can be used without converting the drawing

from top-view to normal-view.

3. The starting point of each dished hole must lie on the central axis of the geometry.

4. Avoid clicking Clear Mark before completing the hole settings, as this may remove necessary

reference lines.

5. Bevels can be added to dished holes. You can either adding bevels to the original graphics first,

then assign dished hole attributes, or defining all dished holes first, then apply bevels. After a graphic

has been assigned a dished hole property, it becomes grouped. You must ungroup it before applying

bevels.
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2.5 Bevel Settings

2.5.1 Bevel Property

Figure 2-27 V bevel parameters

Select the graphics to be featured by bevel, click Bevel Property and set relevant parameters to add

required bevels.

Before setting bevel parameters, confirm the toolpath type (inner or outer) of the part. Then

determine the top/bottom bevels based on the reference diagram (the shaded area indicates the retained

part of the workpiece).

For standard V bevels, set Angle ∠1 and Reference Dimension. Alternatively, you can Customize

bevel by width. The relationship between V bevel geometry and cross-section diagrams is illustrated

below. Drawing Size refers to the size of the selected shape. Big/Small part size refers to the workpiece

size for external cuts and to the sheet size for internal cuts.

Use big dimension as reference Use small dimension as reference

Top Bevel

Bottom

Bevel

Figure 2-28 V bevel parameter and cross-section diagram
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If the parts need to be intersected and welded with round or square tubes, please select Fixed V

Bevel and set Bevel Angle and Phase Angle respectively in Special V Bevel; if you need to process

gradual bevel, please select Gradual V Bevel in Special V Bevel and set Start Angle and End Angle

respectively.

Figure 2-29 Fixed V bevel parameter

Figure 2-30 Fixed V bevel

The diagram shows how the top and bottom surfaces align relative to the phase angle.

Notice: Gradual bevel is for open toolpath only!
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For Y bevel, three Toolpath Section Params combinations are supported: Use Bevel Angle + Width,

Use Bevel Angle + Land, and Use Bevel Width + Land. Depending on the selected combination,

corresponding input fields will become available. Fill in the required values and click OK.

Figure 2-31 Y bevel parameters

For X bevel, three toolbath section param combinations are supported: Use Bevel Angle + Width,

Use Bevel Angle + Height, and Use Bevel Width + Height. Depending on the selected combination,

corresponding input fields will become available. Fill in the required values and click OK.

Figure 2-32 X bevel parameters
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For K bevel, three toolbath section param combinations are supported: Use Bevel Angle + Width,

Use Bevel Angle + Height, and Use Bevel Width + Height. Depending on the selected combination,

corresponding input fields will become available. FACut will automatically calculate the land height for

K bevels. Enter the parameters as required and click OK.

Figure 2-33 K bevel parameters

To improve weld penetration strength, FACut allows defining a Bevel Root Gap. This ensures full

contact between the molten weld and the workpiece, enabling full-penetration welding. This setting is

located below the bevel cross-section diagram. Use this setting based on your process requirements.

Figure 2-34 Diagram

If a specific cut order is needed, Y, X, and K bevels support Reverse Toolpath. This setting is also

located below the bevel cross-section diagram, and the cutting sequence is shown in red text. When

enabled, the cut sequence will update accordingly and display in bold red text on the right. Use this

setting based on your process requirements.
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2.5.2 Create Special Bevel

FACut supports creating special bevels such as top-round bottom-square frustum, which is

characterized by two curves with different shapes on the upper and lower surface. It is necessary to select

two straight cutting path to-be-beveled before adding special bevel, then click Create Special Bevel in the

drop-down menu of Bevel Property to enter its modification interface.

Once inside, the top and bottom cut paths will be assigned automatically. You can also click Switch

upper and lower surfaces to modify.

If the path directions are inconsistent, a prompt will appear showing Upper and lower surface line

directions are inconsistent. Select a curve and click Reverse to fix.

Click Edit normal vector and set the Normal vector density to visualize corresponding points

between top and bottom surfaces.

FACut can simulate the cutting process to verify if the bevel angle exceeds machine limits. If

exceeded, an error Mechanical motion range exceeds soft limit will be triggered. In this case, reposition

the start points so their connecting line points to the geometry’s center, as shown below:

Figure 2-35 Special bevel normal vector

To apply a special bevel to multiple shape pairs, uncheck Current Only. If only the angle varies,

enable Angle Sensitive for batch processing. Layer-specific settings can be achieved by enable

Distinguish Layer, and special bevel can Apply to all nest results.

To modify an existing special bevel, select the shape and click Create Special Bevel again to re-enter

the edit interface. To revert it to its original geometry, click Reset Special Bevel in the drop-down menu.
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Notice: To create a sample top-round bottom-square frustum, you can draw a 100×100 square,

then draw a similar-sized circle inside. Select both and use Center Align. After entering the bevel

interface, align path directions, and make sure start points face the same way.

2.5.3 Set Blind Bevel

FACut’s blind bevel feature enables parametric configuration of multiple adjacent straight/beveled

segments on a single contour. This allows the machine to start cutting bevel at any position along the path.

The system will automatically generate transition lines between adjacent bevel and straight segments.

Select the desired contour, then go to Drawing→ Bevel→ Bevel Property, and choose Set Blind

Bevel from the drop-down menu to open the blind bevel setting window.

Figure 2-36 Blind Bevel Settings

You can define the Total toolpath segment, and configure the bevel type for each segment in the

table below. Click Add Toolpath to insert a new segment (length defaults to 0) at the end of the current

segment group. When only one unconfigured segment remains, click Auto complete unset segment

length to automatically assign the remaining length to fill the entire contour.

Currently, blind bevel only supports straight cuts and V bevels, with optional root gap for V bevels.

You can apply the same blind bevel configuration to multiple segments of identical length. When a

segment is locked, it turns gray and both its length and bevel attributes become non-editable.

Segments are ordered from start to end of the contour. To reverse the segment order, select Reverse
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Blind Bevel Toolpath from the Bevel Proverty drop-down.

FACut allows saving frequently used blind bevel settings:

 Save to bevel library: Save current blind bevel settings (name and thickness required). Saved

parameters include: thickness, total length, number of segments, segment lengths, and bevel

parameters per segment.

 Override to bevel library: Overrides the currently set blind bevel parameter to an existing parameter

in the bevel library. Name and thickness remain unchanged; all other parameters are replaced.

 Read from bevel library: Select a set of parameters and click Read Parameters, current blind bevel

parameters will be refreshed to the selected parameters.

Click Insert to the end to append the selected parameter set to the current list. If the total length

differs from the current contour, each segment length is scaled proportionally. For locked segments, the

total length remain unchanged. When inserted to the end, all inserted segment lengths remain unchanged,

regardless of lock status.

Figure 2-37 Manual blind bevel

FACut also supports manually creating blind bevel transition lines.

Workflow:

Step 1 Apply standard bevels to each segment of the contour. For full-penetration welds, remember to

set root gap.

Step 2 Navigate to Drawing→ Bevel→ Manual Blind Bevel (or selectManual Set Blind Bevel from

dropdown).

Step 3 Click on two adjacent segments, and a transition line will be automatically generated between

their start and end points.

Step 4 Right-click or press Esc to exit manual blind bevel mode after finishing.



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 32

If you wish to remove blind bevels:

Step 1 Using Reset Toolpath will reset all bevels on the part, including non-blind bevels.

Step 2 Instead, useManual Clear Blind Bevel from theManual Blind Bevel drop-down.

Step 3 Click on the desired contour to revert the entire blind bevel segment to a straight cut.

Notice:

1. When manually creating blind bevels, follow the contour direction when selecting segments.

2. To remove a blind bevel, you must select and reset the entire blind bevel path in one go.

3. Manual blind bevel can only be applied to paths without Bevel Extend.

4. For one path cutting contours, do not manually add a blind bevel transition line after

splitting/breaking the tool path and setting the bevel separately.
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2.5.4 Toolpath Split

Using a closed rectangle as an example, if a bevel is applied directly to the entire part, all toolpaths

are treated as a single cut completed in one pierce, and the corners are processed using pre-adjusted

normal vector transitions.

When one path cutting bevels do not provide sufficient process stability or when higher cutting

quality is required, use the Drawing→ Extend toolbar to apply either Auto Split orManual Break. Auto

Split automatically adds split points at corner nodes of the part. Manual Break allows manually add split

points along continuous toolpaths.

Please note that the original graphics remains intact after split/break and exhibits the following

characteristics:

 Drag operation is only validated for whole part.

 Different bevel properties and layer can be set for different cutting paths.

 Attributes of a single toolpath are determined with respect to the entire part geometry.

 For corners with large angles, one path cutting may suffice to meet tolerance and quality

requirements. Considering this, FACut also supports custom Auto Split Params.

Figure 2-38 Auto split params setting

 Open the Auto Split drop-down and select Auto Split Params, then the Auto Split Params

Setting window will pop up.

 Check Enable Auto Break Params and set the split angle. When the corner is less than or equal

to the split angle, the graphic will be automatically split, otherwise, it remains one path cutting.
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The concave angle is not split.

 This feature is disabled by default, and supports parameter memory (default threshold: 120°).

 If previously split toolpaths need to be recombined, useMerge Toolpath of the Extend toolbar. Hold

Shift to select multiple toolpaths. To restore the geometry to its original state, use Reset Toolpath

from the Merge Toolpath drop-down. This will also reset any added techniques, layers, and features

associated with the geometry.

2.5.5 Bevel Extend

After a bevel is applied, the resulting toolpath is generally closed to ensure part integrity. However,

in some complex cases or after compensation adjustments, the cutting path may become non-closed.

Figure 2-39 Bevel extend

To address this, select the two unconnected toolpath ends, then click Bevel Extend in the Extend

toolbar to restore path continuity. The Bevel Extension drop-down offers the following modes:

 Manual Extend: Select specific edges to extend.

 Auto Extend: Automatically extends all bevels in the selected geometry.

 General Extend: Automatically extends all eligible bevels in the current view.

To remove previously applied bevel extensions, select the geometry and click Cancel Bevel Extend

from the drop-down.

Additionally, enable Auto Extend After Compensation to automatically re-extend corner edges after

bevel compensation is applied.
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Chapter 3 Technique Settings

This section introduces the technique settings available in FACut. Since most parameters are directly

related to factors such as material properties, laser source, and gas pressure, please configure these

parameters according to your actual processing requirements. All parameters mentioned in this

section—including those shown in images—are for demonstration purposes only and should not be

considered as process recommendations.

Caution: Improper or incorrect parameter settings may degrade cutting quality or even damage

the machine. Proceed with caution.

3.1 Leadline

3.1.1 Identify Inner/Outer Contour

When importing external files (e.g., *.dxf), FACut will automatically distinguish between inner and

outer contours. If any edits are made to the path that change the contour relationship, click Sort (any

sorting method will re-analyze the contours), or click the drop-down arrow next to Lead, and select

Identify Inner/Outer Contour.

Figure 3-1 Sort and Identify Inner/Outer Contour

FACut distinguishes contours based on containment relationships: The outermost closed shape is

treated as an outer contour (outside cut). The next enclosed shape becomes an inner contour (inside cut),

and so on, alternating layer by layer. Open contours cannot be recognized as valid layers.

When adding leadlines, leadlines for outer contour starts from outside, while from inside for inner

contour. To manually define cutting direction: select the geometry, then click Outer or Inner accordingly.

Figure 3-2 Inner
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3.1.2 Auto Leadline

Select the graphic to be set leadline, and click Lead in the top toolbar. In the pop-up window,

configure the following parameters:

Figure 3-3 Lead

Figure 3-4 Leadline setting

The supported lead type include Arc, Line, and Arc + Line. The supported parameters include Type,

Angle, Length, and Radius. You can also add small hole at leadline start point.

Notice: FACut will automatically choose an appropriate lead-in position based on preferred part

tip or preferred long edge, as previously defined. Any existing lead-in settings on the geometry

(position/type) will be overwritten. If a fixed lead-in position is required, select options such as A

ratio to the total graphic length(0~1) or Keep lead position, only change type.
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3.1.3 Manual Leadline

Click Start Point to change the lead-in line manually. Click a point on the graphic to change the

lead-in location, while keeping the angle and length unchanged.

Figure 3-5 Start point

Figure 3-6 Change lead-in line position

Click point A outside the part, then click point B on the contour. FACut will draw a straight-line

lead-in fromA to B.

Figure 3-7 Manual leadline

3.1.4 Check Leadline

Click Lead drop-down menu and select Check Leadline. This function will examine all leadline and

automatically shorten overly long leads to prevent interference or crossover with other parts. Click

Identify Inner/Outer Contour to re-determine leadline positions based on current inner/outer contours.

Notice: In certain toolpath split scenarios, toolpaths are designed to intentionally intersect

(interfere). Such interference may be normal and expected.
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3.2 Kerf Compensation

To apply kerf compensation, select the desired geometry and click Compensation on the toolbar.

After configuring the compensation parameters in the pop-up window, click OK to apply.

Figure 3-8 Compensation parameter

The kerf width should be measured based on actual cutting results. After compensation, the new

toolpath will be displayed in green on the CAD panel and used during cutting. The original geometry will

not be cut—it is only shown for reference.

The kerf compensation can be manually set as All shrink or All expand. Or, it can be automatically

determined based on the cut type: Inner shrink, expand outer/Outer shrink, inner expand. You can also

choose the corner transition type between fillet and sharp corners, as shown in the figure below:

Figure 3-9 Kerf compensation corner

In the image, white cutting path is the original one and green is the compensated. It can be seen that
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the compensation on both sides of the vertical line can ensure that the side of cutting path coincides with

the original trajectory, but the corner needs transition. Fillet transitions typically ensure smoother paths

and better alignment with original edges, especially at corners.

FACut supports two Compensation Type:

 Kerf Width: Compensation width is measured along the laser beam direction.

 Surface Width: Compensation width is measured along the surface of the sheet.

Figure 3-10 Compensation type

To cancel Compensation, please select the figures first, then navigate to the drop-down menu of

Clear and click Clear Compensation; Or directly click the Clear Compensation in the compensation

setting window.
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3.2.1 Bevel Compensation

Check Enable Bevel Compensation in the compensation window, click the right gear icon to

configure compensation values based on bevel type, angle, etc. Bevel compensation parameters can be

saved and read as independent files, and the system automatically detects overlapping angle ranges.

Figure 3-11 Bevel compensation settings

Two compensation modes are available:

 Standard: Matches values based on top/bottom bevel and angle range, regardless of bevel type.

 Fine: Further distinguishes bevel types (V/Y/X/K), matches values using bevel type, top/bottom, and

angle range.

This interface also supports setting straight-cut compensation. For undefined angles in the table,

default straight-cut parameters will be applied.
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3.3 Ring Cut

Click Ring Cut on the toolbar after selecting the geometry to improve sharp corner cutting

performance.

Figure 3-12 Ring cut

3.4 Microjoint

Microjoint insert uncut segments along the path to prevent part lifting after cutting. The laser turns

off at the microjoints. Visually, a micro joint appears as a gap, optionally with a white frame if Display

Microjoint Tag is enabled.

Figure 3-13 Microjoint

Click Microjoint and then click the desired position on the contour to insert. You can continue

adding multiple joints until pressing ESC or switching tools. Microjoints can be added even after

compensation.

Figure 3-14 Manual microjoint
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When adding microjoints manually on graphics for the first time after clicking Microjoint, it is

necessary to set Microjoint Length in the pop-up window, and you can also Apply microjoint to similar

graphics, Change start point to microjoint, and Add lead at microjoint. In addition, you can also modify

microjoint length by clicking Modify Microjoint in its drop-down menu, and the value will be validated

on the microjoints added later.

Moreover, it is possible to apply Auto Microjoint. Click Auto MicroJoint in the drop-down menu,

set the parameters in the pop-up dialog, and then click OK to get it started. There are two patterns of

adding microjoint: by total number or by interval. For example, you can choose to add 10 microjoints to

each figure, or add microjoint to part geometry every 100 mm interval.

Figure 3-15 Auto microjoint
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3.5 Gap

These four options Seal, Gap, Over-Cut, and Multi-Cut are integrated in the drop-down menu of

Gap. Select graphic and click the target function.

A closed shape by default is sealed, which means the start and end point converge at a same point;

Gap means the start and end point doesn’t join together with a gap in between, while Over-Cut is to add

an extra path at end point.Multi-Cut means repeating cut along the same pass for target times.

Click Gap/Over-Cut tab to pop up the Gap/Over-Cut Settings, and click Multi-Cut to pop up the

cutting counts settings. The setting of Gap/Over-Cut size is only valid for those to-be-set later, not the

ones have been set before.
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3.6 Relief/Fillet

Click Relief to create a release notch for bending process.

Figure 3-16 Release

Click Fillet to open the fillet setting dialog. Select type and size, then click target corners to apply.

Figure 3-17 Fillet

Use Fillet All in the drop-down menu of Fillet to auto-apply chamfer to all eligible corners in

selected contours.
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3.7 Cooling Point

Click Cooling Point in the top toolbar and click desired positions on the contour. During cutting, the

laser will pause at these points, stop firing, and delay while blowing air, then resume the cutting. The

delay can be set in Global Parameter→ Gas Parameter→ Cooling Delay. Cooling points are displayed

on the CAD panel as solid white dots, as shown below:

Figure 3-18 Cooling point

Multiple cooling points can be inserted continuously. Still available after micro joint or

compensation.

FACut also supports Auto Cooling Point. Click Auto Cooling Point in the drop-down menu, set the

parameters in the pop-up dialog, and click OK to apply. Cooling points can be automatically added at

lead-in points and sharp corners. If added at the end of a lead-in, the cooling point becomes part of the

lead-in, not an independent cooling point. It will move or be deleted along with the start point and cannot

be removed using the Clear Cooling Point function.

To delete cooling points, you can hold Shift and click them. If you want to delete all cooling points,

select the graphic, and select Clear Cooling Point in the drop-down of Clear to delete all cooling points

already set.

Cooling points are commonly used in corner processing. They help by pausing the cut and activating

air blowing to cool the area, which prevents corner burning.
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3.8 Technique Mark

Click Technique Mark in the lower left toolbar.

Figure 3-19 Technique mark

In the Add Technique Mark dialog that appears, configure the mark ID, the effective segment of the

technique, and relevant parameters. Click OK, then click the desired position on the path where you want

to apply a specific technique. A technique mark point will be added.

Figure 3-20 Add technique mark

It will be displayed as a yellow point in drawing board, labeled with their ID as shown below:

Figure 3-21 Technique mark
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During processing, the system will apply the corresponding technique settings within the path

segment defined by the technique marks.

FACut supports adding up to nine different types of technique marks.

 To modify a technique associated with a mark point, select its ID in the Add Technique Mark dialog

and update the parameters.

 To delete a technique mark point, enter the technique mark setting mode, hold Shift, and click the

point to remove it.
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3.9 Technique Settings

FACut provides 17 layers in total, among which layer 0 is the unprocessed layer. Each of the

remaining layers can be configured independently with technique parameters such as cutting speed, laser

power, gas pressure, nozzle distance, etc.

Figure 3-22 Technique settings

Click Technique on the right to open the Technique Settings window, almost all parameters during

the cutting process are included. Click each layer to set the corresponding technique independently. Each

layer corresponds to specific toolpaths, and different bevel toolpaths within the same layer can also be

configured individually.

Notice: Although toolpaths A, B, and C under the same layer appear in the same color, their

technique parameters are independent. When composite bevels (Y, X, K) are applied to a geometry,

the cutting, piercing, and power curve parameters for toolpaths A, B, and C must be set separately in

the technique setting interface.
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If one toolpath shares the same technique parameters with another or only needs minor adjustments,

you can use the Copy function to quickly duplicate parameters. The logic is Copy from Toolpath A/B/C.

For example, to copy parameters from toolpath A to toolpath C, go to toolpath C’s settings interface and

click Copy→ Copy from Toolpath A.

Otherwise, if you set the technique parameters for other layers, it is possible to copy the parameters

from one toolpath of other layers. You can also copy technique parameters across layers. For example, to

copy toolpath A’s parameters from layer 1 to layer 2, go to toolpath A under layer 2, click Copy, then

select Copy from Layer 1→ Copy from Toolpath A in the drop-down menu.

You can also click Copy Layer to batch-copy all layer parameters from another layer.

3.9.1 Cutting & Piercing Parameters

Table 3-1 Cutting Parameters

Name Description

Cut Speed
Sets the target speed of actual cutting. Actual speed may be lower due to

acceleration/deceleration at the start, end, and corners of the path.

Nozzle Distance Sets the height of the cutting head from the plate during cutting.

Gas Type Sets the type of assist gas used in cutting.

Gas Pressure
Sets the air pressure of assist gas during cutting, used with a proportional valve

or multivalve.

Assist Pressure: Sets the gas pressure for the assist gas when using high-speed following nozzle.

Peak Power

Sets peak power of fiber laser. Peak power determines the maximum cutting

power that the machine can achieve. If a 3000 W machine sets peak current at

80%, the maximum cutting power will be 3000 W * 80% = 2400 W.

Duty Cycle Sets the PWM duty cycle used in machining.

Pulse Freq
Sets the carrier frequency of the PWM modulation signal, which represents the

number of laser emissions per second.

BeamWidth A default parameter for cutting head, no need to make modifications.

Focus Position The distance between the focus and the nozzle tip of the cutting head.

Dwell Delay time for burning the plate through to ensure complete cutting.

Laser Off Delay A delay before turning off the laser to ensure the cutting path is fully completed.
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Name Description

Defilm Cutting

If enabled, the Defilm Parameters tab will appear in the technique settings

interface. Before actual cutting, the cutting head will remove the film in the

vertical state according to the preset parameters. This applies only to layers

where defilm cutting is enabled.

Laser On Parameters
Allows the use of specific parameters for the initial segment of the cutting path

and supports setting lead-in height.

Laser Off Parameters
Allows the use of specific parameters for the final segment of the cutting path

and supports setting lead-out gas pressure.

Smart Laser Off

If enabled, burrs at the end of the cutting path for closed shapes can be avoided.

Only applicable when using a BLT cutting head and cannot be enabled

simultaneously with lead-out parameters.

Lead Technique
Sets the starting speed, duty cycle and pulse frequency separately when cutting

leadlines.

Lead Slow Descent

After activating the laser at lead-in height, the head gradually descends while

cutting. The stable distance refers to the distance from the start point to the point

where the head reaches the processing height.

Lead Circle Speed If a lead circle is added, this sets its cutting speed.

Lead Focus
Adjusts focus during lead-in cutting. Starts with the lead-in focus and transitions

to the processing focus after the Start length.

Table 3-2 Piercing Parameters

Name Description

Segment Pierce Suitable for all plates, stable and simple.

Incremental Pierce
The cutting head gradually moves from high to low during piercing, reducing burrs

and improving lead-in quality.

Flash Pierce
Suitable for Carbon Steel cutting with Oxygen. For plates thicker than 12 mm, it is

recommended to use along with Segment Pierce.

Smooth Pierce Laser turns on during following, and cutting starts once the head reaches position.

Tilted Pierce Before bevel path cutting begins, the head swings to cutting position and pierces.

Pre-Pierce Execute Pre-pierce at the start point before actual cutting.
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3.9.2 Advanced Parameters

Table 3-3 Advanced Parameters

Name Description

Speed Constraints
Constraint max swing speed at coincident points during the piercing and

machining process.

Vibration

Suppression

It is used to suppress the vibration when cutting thick plates. It is recommended to

enable the Adaptive Algorithm.

Interpolation Follow

Feedforward

When enabled, accelerates the height controller’s response speed, helping to

avoid collisions on uneven materials. Cannot be used simultaneously with

vibration suppression.

Short travel no lift

Available only for the First Layer (i.e., marking layer). When enabled, allows

movement between two marking paths without lifting if the distance is shorter

than the no-lift distance.

Use external device

marking

When enabled, adds an External Device Marking layer where users can set

cutting speed, dwell time, laser-off delay, and short distance no-lift parameters.

Adjust Microjoint
When enabled, all microjoints on the layer will be adjusted to the specified

length, calculated from the tail end of the original micro joint.

Smooth Microjoint

When enabled, all micro joints on the layer become seamless. During cutting, the

system will follow the set duty ratio, speed, focus, and pressure. Root Ratio =

100% - Duty Ratio.

Deslag Parameter Performs slag removal after piercing to avoid burrs affecting cutting quality.
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3.9.3 Real-time Power/Frequency Adjustment (Power Curve)

Enables real-time adjustment of laser power (PWM duty ratio) and frequency according to

user-defined curves. This is particularly effective for improving corner cutting quality.

Figure 3-23 Power curve

Notice: Real-time frequency and power should be enabled simultaneously.

3.9.4 Gradual Bevel Technique

The gradual bevel technique uses a similar interface to the real-time power/frequency adjustment. By

defining curves for bevel angle versus power, frequency, pressure, and focus, the technique allows

real-time adjustment during cutting. Only the parameters with checked curves will be applied.

Figure 3-24 Gradual bevel technique
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The curve can be edited via the Edit Curve interface by adding, deleting, or adjusting nodes

(dragging or inputting coordinates directly). FACut supports saving and reading gradual bevel technique

curves in *.lcm file format. The saved file contains only the currently edited curve. When loading a file,

the gradient bevel technique will overwrite only the current toolpath.

Figure 3-25 Gradual bevel technique curve adjustment
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3.9.5 Save and Read Technique

There are two ways to save and read FACut technique parameters: save to/read from technique

library or from files. The former saves parameters by toolpath. Suitable for saving techniques after

debugging on the machine for future production use. The latter saves parameters by layer. Suitable for

backing up techniques as files or transferring them to other machines.

 Save to Technique Library/Read from Technique Library

Click Save to Technique Library to open the Save Technique window, where you can set material

type, thickness, nozzle name, nozzle diameter, gas type, and angle for the process. A file name will be

generated based on these parameters. Notice: This file name is used within the technique library and

differs from the file name when saving to a file. After saving, the technique can be viewed in the

technique library. A Custom name can also be set for easier retrieval and application.

FACut provides several predefined material types, and users can click + on the right to add custom

materials. Nozzle names and abbreviations must be manually defined, you can do this by clicking + to

add custom nozzles. The default cutting angle is 0° (straight cut), but users can add custom angles using +.

Click OK to save current parameters as a technique, or - to remove the newly added parameters.

Figure 3-26 Save technique
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Click Read from Technique Library to select a saved toolpath technique and override the current

one; you can also click Override to Technique Library to overwrite the preset technique in the library

with the current one(the file name remains unchanged).

Figure 3-27 Read from technique library

 Read from/Save to file

Click Save to File to save the current Layer Parameters as a material library file (*. lcm). To load a

saved process, click Read from file and select the required material library file. This will overwrite all

toolpath technique parameters and user-defined names for the current layer.
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3.10 Manage Technique

Click Production → Manage Technique on the top toolbar to manage the technique that has been

saved in the technique library and delete materials and nozzles without corresponding technique

parameters. You can sort the techniques by material, thickness, gas type, nozzle type, bevel angle, and

laser power.

Figure 3-28 Manage technique

Click the icon under Modify to modify the technique parameters and user-defined name of the

toolpath, which is similar to the technique settings window; Click the icon under Delete to delete the

saved technique; Click the icon under Set as Common to add designated technique to the Common page,

and click it again to cancel.

When using BLT cutting heads, Import recommended technique is available.

Figure 3-29 Recommended technique
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If you want to back up the toolpath techniques in the technique library as files, select the technique

to be saved, and click Save to file to save the selected technique as a Material Library File (*. fam). Click

Read from File to load a saved technique, then click Select in the pop-up window, open the *.fam file,

and select the technique to be imported. If the name of the to-be-imported technique file is the same as

that of a preexisting one, choose an appropriate handling method and click Import to complete the

process.

Figure 3-30 Import technique
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Chapter 4 Tools

This section introduces the tools provided by FACut during the drawing processing stage. Please

configure them according to actual processing requirements. All parameters mentioned in this section,

including those shown in images, are for demonstration purposes only and should not be considered as

guidance values.

4.1 Array

Array refers to the duplication and arrangement of one or more shapes into a grid based on specified

row and column offset or interval. This function helps create layouts of multiple identical or similar

workpieces, enabling batch processing and improving production efficiency. FACut supports generating

Rectangular Array and Polar Array.

4.1.1 Rectangular Array

Select the shapes to be arrayed and click Array or Rectangular Array in the drop-down menu to

open the parameter settings interface:

Figure 4-1 Rectangular array parameters

When Array Layout is set to Offset, row/column spacing refers to the distance between the same

reference point of the shapes. When set to Interval, it refers to the distance between the closest edges in

horizontal/vertical directions.

After configuring row and column counts, spacing, and direction, the selected shapes can be quickly
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duplicated into an array.

Figure 4-2 Rectangular array

4.1.2 Polar Array

Select the shapes to be arrayed and click Polar Array in the drop-down menu of Array to open the

parameter settings interface:

Figure 4-3 Polar array parameters

You can configure the array either by Angle Spacing or by Array Range. In Angle Spacing mode,

the Number of shapes must not exceed the maximum number allowed within 360° based on the specified

angle spacing by entering Degree. Otherwise, the array will be generated according to the actual

maximum number. In Array Range mode, the system calculates angle spacing based on the set total

Range and Number of shapes.

You must also set the Array Center. When Array Center is checked, a preview of the array will be

shown. Array Radius is the distance from the shape center to the array center. Relative Angle defines the

relative angle of the shape’s position in the array. If the Array Center remains unchecked, after clicking

OK to exit the interface, you need to manually specify the center of the array in the CAD view, and the

FACut will automatically generate a circular array upon a single click.
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4.2 Fly Cut

When the shapes are regular (e.g., rectangles, full circles, polygons) and arranged in a certain pattern,

fly cut can link straight segments in the same direction into a continuous cut path. This improves cutting

speed and reduces time.

Before fly cut, it is recommended to sort the graphics to optimize the path of fly cut and save travel

time.

Click Fly Cut or Linear Fly Cut in the drop-down menu to enter the parameters setting page of

linear fly cut.

 Start position: Defines the cutting start location.

 Tolerance: Maximum offset allowed between arrayed shapes.

 Max smooth joint: Maximum spacing allowed for smooth connections between turns.

Figure 4-4 Linear fly cut

When all arrayed shapes are circles, clicking Fly Cut will open the Circular Fly Cut settings, or you

can choose it from the drop-down.

Figure 4-5 Circular fly cut
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 Max circle spacing: Maximum distance allowed between two circles to form a fly cut path. If the

distance between two circles is greater than the set value, fly cut setting will fail.

 Sort before fly cut: Sorts all selected shapes before fly cut.

 Fly cut by part: Sorts and fly-cuts shapes within each part individually.

When both are checked, the machine will fly cut each part internally by sorting rules before cutting

by part.

Figure 4-6 Fly cut by part

Figure 4-7 Fly cut not by part

Safe fly cut: Avoids holes and small inner shapes during fly cutting (minimum supported: > 0.5 mm

diameter circles).

You can configure Fly cut overcut through Global Parameter → Motion Control Params → Path

Interpolation Parameter to ensure part separation after cutting.
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4.3 Co-edge

Co-edge is to merge the common edge of multiple parts into one, capable to reduce actual cutting

length and parts gap for better processing efficiency and plate utilization rate. FACut supports creating

parallelogram straight-cut co-edge arrays and V/Y/X/K bevel co-edge arrays.

4.3.1 Manual Co-edge

FACut supports auto attach for co-edge in both horizontal and vertical direction. Move a part close to

another with which it may share an edge. FACut will attempt to automatically snap them together and

display a prompt.

When dragging two or more parts simultaneously, FACut will snap them into position if possible,

enabling quick layout adjustments. In addition to manually dragging parts together, you can also create a

set of co-edgeable parts by generating a rectangular array. Currently, only rectangular arrays support

co-edge. To achieve co-edge, the part spacing must be set to 0.

Figure 4-8 Manual co-edge

Select two or more graphics, click Co-edge, then FACut will try to merge the selected parts. If

selected parts are recognized as an array, the Rectangular Co-edge dialog will appear. Set the co-edge

pattern and click OK to generate a co-edge layout. Once co-edged, the participating parts are grouped into

a co-edge group.

Figure 4-9 Rectangular co-edge
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Notice:If any part in the group contains internal geometry (e.g., holes), group the part and all its

inner geometry before applying co-edge. Otherwise, the relationship between internal geometry and

the co-edge group will become invalid, which may cause issues in processing order or inner/outer

profile recognition.

4.3.2 Bevel Co-edged Array

Draw a rectangle, or a parallelogram with polyline, choose Auto Split or Manual Break. After

splitting, you can apply bevel properties on these separate lines.

Select the parallelogram intended for co-edged arraying, click Bevel Co-edged Array in the

drop-down menu of Co-edge, in which you can set array quantity, row direction, not co-edged parts

interval (used when full co-edge is not possible). Click OK to generate the bevel co-edge array.

If the graphic selected cannot be co-edged, there will be a notification of failed operation in the

log&alarm interface.

Figure 4-10 Bevel co-edge array

FACut supports flipped co-edge for V bevels and full co-edge for symmetric X/K bevels. If a

row/column cannot be fully co-edged, FACut will insert a pseudo co-edge based on the not co-edged parts

interval.



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 64

The diagrams below illustrate flipped/full bevel co-edge array and partial pseudo co-edge array.

Figure 4-11 Bevel co-edged array

Figure 4-12 Bevel co-edged pseudo array
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FACut now supports bevel co-edged array for parts with bevels on adjacent edges. After setting the

array parameters and clicking OK, an additional dialog—Set remove size when interference is found in

Bevel Co-edged Array—will appear. By setting a radius, the system will automatically create chamfers in

the interference zones to prevent collision between co-edged bevel toolpaths during cutting.

Figure 4-13 Set remove size when interference is found in bevel co-edged array

Figure 4-14 Diagram of chamfers
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4.4 Cut-off Line

When cutting off remnant material or beveling along the plate edge, starting directly from the edge

may lead to nozzle collisions. You can solve this problem by setting the trajectory as a cut-off line.

Select the trajectory to be set as cut-off line (ensure its length matches the edge to be trimmed), click

Cut-off Line to set the cut-off line parameters in the pop-up window, and configure the cut-off line

parameters in the pop-up dialog. After clicking OK, a blade-shaped icon will appear at the path’s start

point in the CAD panel, indicating the cut-off line has been set successfully.

Figure 4-15 Cut-off line mark

You can set the out-plate method of the cut-off line as either Fixed Height or Only follow upward.

The latter helps reduce the risk of nozzle collion during lift-off.

Figure 4-16 Cutoff parameter settings

If you need to cancel the cut-off line, select specific trajectory and choose Cancel Cut-off line in the

drop-down menu of Cutoff Line.

Every time you open FACut, there will be a pop-up window of Cutoff Parameter Settings only

when the cut-off line is set for the first time. After that, if you need to modify the cutoff settings, click the

drop-down arrow and then click Cutoff Parameter Settings.
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FACut supports bevel cut-off lines and side wall bevel cutoff from the edge of the plate, eliminating

the need to flip the plate. The following example demonstrates how to perform side wall bevel cutoff

using a C path of a K bevel.

Step 1 Find Edge

The accuracy of side wall bevel cutoff depends on the Find Edge accuracy. Before setting cut-off

line, it is necessary to execute Find Edge and confirm whether the Find Edge result is accurate by Frame

and Dry Run. You should also set the appropriate margin for Find Edge to ensure that the zero point

(cut-off start point) aligns with the plate corner.

Step 2 Set Bevel

Draws a straight line with its Bevel Property set as K bevel. Set the required angle and root height,

and modify the cutting sequence to C→ B→A to prevent prevent slag buildup. If the tool order is not

modified in Bevel Property, it can be realized by Manual Sort. After the bevel setting is completed, set

toolpath B to layer 0.

Figure 4-17 Set bevel

Step 3 Set Cut-off Line

Go to Cut-off Line → Cut-off Line Settings, configure cut-off parameters, Follow shrink dis (the

distance to move inward before detecting), and Outward distance of safe lift (distance to extend outward

before lifting). Select toolpath A, click Cut-off Line to define it as a normal cut-off line. Select the

toolpath C, and in the drop-down menu, click Side Wall Bevel Cutoff. A special icon will appear at the

toolpath C-path’s start point, indicating the side wall bevel cutoff line is set. Once the side wall bevel
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cut-off line is defined, the system will automatically calculate the zero ref. Please confirm that the zero ref

lies on the plate edge.

Figure 4-18 Set cut-off line

Figure 4-19 Cut-off line

Notice:

1. The default technique layer for a cut-off line is Last Layer. After setting the cut-off line, ensure

appropriate cut-off technique parameters are configured.

2. FACut supports any shape for straight cut-off lines, but only straight lines are supported for bevel

cut-off lines.

3. Detect Cutting must be enabled in Global Parameter before using side wall bevel cutoff line.
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4.5 Corner Split

This function is designed for the transition between straight cuts and bevel cuts, and must be used in

conjunction with Normal-Based Optimization.

Figure 4-20 Corner split setting

Under normal circumstances, after enabling Normal-Based Optimization, the cutting head will

begin tilting at the start point of the straight edge preceding the bevel edge. By the time it reaches the

bevel edge, the cutting head will have adjusted to the required cutting angle. As shown in Figure 4-21, the

cutting head has already started tilting (highlighted in red).

Figure 4-21 Before corner split

After a corner split point is set, the cutting head will maintain a straight cutting posture between the

start point of the preceding straight edge and the corner segmentation point, as shown in figure 4-22.

Figure 4-22 After corner split - before the split point
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Once the cutting head reaches the segmentation point, it begins tilting and will reach the required

bevel cutting angle precisely when it enters the bevel edge, as shown in figure 4-23. This helps maintain

the cutting quality of the straight section to some extent.

Figure 4-23 After corner split - after the split point

During corner segmentation, it is supported to use the adjacent bevel technique layer to cut the

straight edge segment where the cutting head tilts. To enable this, check Use adjacent bevel toolpath

layer. As shown above, the toolpath layer after the segmentation point matches the bevel layer.
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4.6 Bridge

When a part consists of multiple subparts that you don’t want to fall apart after cutting, you can use

Bridge to connect them. This feature also reduces the number of piercing operations. By using Bridge for

multiple times, you can achieve a continuous One-Pass cut effect across all geometries.

To bridge two geometries, click Bridge, set the Bridge Width in the pop-up window, and then draw a

straight line across the screen. All geometries intersected by the line will be bridged in pairs. As shown in

the figure below:

Figure 4-24 Bridge

Notice: After bridging, the graphics become a single entity. Since the cutting of any individual

part won’t be completed until the full one-pass cut is done, pay attention to potential changes in heat

distribution caused by this setup.

4.7 Layer Mapping

Layer Mapping is used to quickly and consistently apply technique parameter settings across

multi-layer drawings. With one-click mapping, users can automatically assign predefined technique

parameters—such as for cutting or marking—to corresponding layers, adapting to different processing

requirements and improving efficiency in technique configuration.

Currently, FACut supports two types of layer mapping: DXF Layer Mapping and Bevel Layer

Mapping.

 DXF Layer Mapping: To use this function, you must assign distinct layers during the drawing

process. After importing the drawing, click Layer Mapping or select DXF Layer Mapping from its

drop-down menu.

The interface will list the detected layer names and quantities. You can assign a corresponding

technique to each layer using the drop-down menus. In the lower-left corner of the interface, there is also
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a checkbox for Enable Bevel Layer Mapping, but this only supports mapping by bevel type, not bevel

angle.

Figure 4-25 DXF layer mapping

 Bevel Layer Mapping: FACut offers a dedicated bevel layer mapping tool for quickly assigning

techniques layers based on bevel drawing attributes. This function supports differentiation by bevel

type and angle, and allows the assignment of corresponding layer techniques. Its features include

sorting, adding new mapping rules, duplicate mapping check, and saving and reading the mapping

rules as files. Two mapping modes are available:

 Standard: Does not differentiate bevel types; matches layer numbers based on top/bottom bevel

and angle range.

 Fine: Further distinguishes bevel types (V/Y/X/K...), matches values using bevel type,

top/bottom, and angle range.

Figure 4-26 Bevel layer mapping

For details about layer mapping, please refer to FACut - Layer Mapping.

https://drive.weixin.qq.com/s?k=AJEAqwcIAAcSz0wajN
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4.8 Nest

It is used to nest the designated parts reasonably on the plate with the highest utilization rate. FACut

supports one-click nesting. To perform this operation, click Drawing → Tools → Nest. Additionally,

FACut provides several optimization parameters for fine-tuning, such as Parts Gap and Plate Margin.

Figure 4-27 Nest

After initiating the nesting function, a sidebar appears on the left, displaying the part library, plate

library, and nesting result. If accidentally closed, you can reopen the part library by clicking Part in the

toolbar, or reopen the plate library by clicking Plate.

The Part Library displays all parts to be nested as thumbnails. Users can add parts by right-clicking a

selected graphic or using the sidebar's right-click menu to import parts. Right-click on the left sidebar to

select Import Standard Parts, Delete All Parts, and Save Unnested Parts.

Plate library shows available plate types and quantities. Plates can be added by right-clicking

selected geometry or importing from standard plate options. The right-click menu also allows Delete All

Plates or save the plates as files.

The Nested column will display the nesting results after Auto Nest, and plates that have been

processed or modified will be marked accordingly in the thumbnail. To return to the original base drawing

after nesting, click Go to Base Drawing (blue box).
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Part of the parameters of Auto Nest are described as follows.

 Click Common Settings in the bottom-right of the Auto Nest window to switch to simplified

parameter mode. Key options include:

 Parts Gap: Minimum distance allowed between parts.

 Plate Margin: Space reserved around the plate border during nesting.

 Detail Settings

 Rotation Angle: Defines allowable rotation angles for parts during nesting. Options include 90°,

180°, Free, or Forbid Rotate.

 Nest Direction: Controls the directional sequence of part arrangement.

 Auto Co-edge: Enables auto co-edge detection during nesting. If Co-edge All is checked, other

co-edge parameters become unavailable.

 Auto Sort: Where you can enable Forbid In-part Sort.

Right-click on the nesting result and click Generate Report to generate nesting report, including the

total cutting length, total travel length, processing time, pricing and other information of all nesting

results. Before it, you can click Report Information to set the report name, pricing method and other text

information on the report.

Figure 4-28 Nest report
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4.9 Sort

FACut supports flexible cutting order management through the Sort function and offers various

auto-sort parameters.

Figure 4-29 Auto Sort

When the Sort type is set to Smart Sort, the panel on the right will display Smart Sort settings. If

By-part sort is set to Grid type, a Grid Style Sort panel will appear in the bottom-right.

FACut also allows Enable Bevel Sort, a unique feature.

 If Quality First is selected, the sorting follows the principle:“Bottom bevel first, then top bevel;

straight cuts before bevel cuts.”

 If Efficiency First is selected, the sorting is optimized for maximum efficiency.

For detailed bevel sorting instructions, refer to the FACut - Enable Bevel Sort.

https://drive.weixin.qq.com/s?k=AJEAqwcIAAccguFIri


FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 76

Chapter 5 Machining control

FACut integrates CAD and CAM functions, and all operations including editing files and setting

cutting parameters can be done in the office or on your own computer. Then you can open the file on the

machine for processing directly.

5.1 Coordinate System

During the design phase, theModel Coordinate System is used, which is independent of the machine

tool. Its origin (zero point) is shown in the red box below.

Figure 5-1 Zero point

During actual machining, a different coordinate system associated with the machine’s operational

state is used. The relationship between the two coordinate systems is illustrated below.

Figure 5-2 Coordinate system mapping

Click Preview in console will display the cutting head position correspond with graphic.
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5.1.1 Machine Coordinates

The machine coordinate system is uniquely determined by the machine structure and machine

parameters. The coordinate system established by clicking Return Origin is consistent at all times. When

the machine is installed for the first time or the mechanical coordinate system deviates due to abnormal

reasons, you can click Return Origin on the top toolbar to reset the machine coordinate system.

Regardless of the machine structure, the coordinate system definition in FACut is consistent.

 Facing the machine from the front:

 Cutting head moving to the right → Positive X direction

 Cutting head moving backward → Positive Y direction

 Viewed from the positive direction of the X/Y axis:

 A/B axes rotating clockwise → Positive direction

 Counterclockwise → Negative direction

Thus, the bottom-left corner of the workpiece represents the minimum coordinates, and the top-right

corner the maximum coordinates.

5.1.2 Program Coordinates

Since machine coordinate is consistent, FACut also adopts program coordinates for flexible

production.

Figure 5-3 Select coordinate system

All program coordinates in FACut share same coordinate direction with machine coordinate—only
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the zero point differs. Program coordinates can be divided into Floating Coordinate System and

Workpiece Coordinate System.

The program coordinate system options are available at the top of the machining control panel,

including Floating Coordinate System and sixWorkpiece Coordinate Systems (1 to 6)

Floating coordinate system is typically used for temporary or trial operations, where “machining

starts from the current cutting head position.” Whenever the user clicks Frame, Dry Run, or Start, the

system automatically sets the current cutting head position as the zero point.

When the Workpiece Coordinate System 1 ~ 6 is selected, its zero point is manually set by the user

through Set Current Position as Zero Point. Once saved, it won’t be changed until you modify it

manually. These coordinate systems are suitable for batch production, with zero-point positions often

defined by fixed fixtures—ensuring that every job runs from the same physical location.

5.1.3 Return Zero under Abnormal Situations

 If only external devices such as the laser or gas system malfunction and machining is interrupted, but

the coordinate system remains intact: you can directly click Return Zero to return to the zero point.

 If accidents like power down or servo alarm occur and deviate from the machine coordinate system,

it is recommended to click Return Origin to reset the machine coordinate, and then click Return

Zero to find the zero point.

 If the production is interrupted due to unexpected circumstances, but the machining is started by

misoperation, and you still want to find the zero point of the last processing, it is possible to locate

Memory Zero to get back to the last zero point. You’re allowed to select Memory Zero in the

drop-down icon next to Return Zero on the console, and then click a specific one to set it as current

zero point.
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5.2 Machining Control

Machining Control is on the right side of the software and contains the following operation bars,

Burst, Jogging, Debugging, and Machining. The control parameters for these functions can be modified

in the parameter settings. The functions of each of these four operation bars are described in detail below.

5.2.1 Bursting

Figure 5-4 Bursting

 Shutter: Controls the laser shutter (on/off).

 Aiming: Controls the laser red light (on/off).

 Laser: With Shutter on, left-click for a single burst, and right-click for continuous shooting.

 Follow: Controls the following (on/off）.

 Blow: Controls the gas (on/off).

 Gas: Select the blowing gas type.
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5.2.2 Jogging

Figure 5-5 Jogging

 Jog Panel: Jog and step controls for X/Y/Z/A/B axes.

 L/M/H: Set low/medium/high-speed jog or step mode.

 Step: If enabled, the cutting head will move by steps of designated distance, or it will move by

jogging.

5.2.3 Debugging

Figure 5-6 Debugging

 Set Mark: Record current X and Y coordinates of the cutting head, saved in the drop-down arrow of

Mark on the right.

 Return mark: The cutting head will lift up and then return to X and Y coordinates corresponding to

designated mark.

 Mark: There are 6 mark points listed in it, you’re allowed to click the drop-down arrow on the right

to switch the mark points or rename them by Edit.

 Frame: The cutting head will move a rectangle surrounding the to-be-processed graphics.
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 Dry Run: The cutting head moves along the graphics without emission laser emission, following, or

gas blowing.

 Return Zero: The machine tool moves to the zero point of the graphic. Clicking the drop-down arrow

on the right allows returning to history zero point.

 Breakpoint: If there are abnormal conditions during actual machining, which lead to machining

suspension by triggering alarm, you can locate to the break point and then start machining;

 Back/ Forward: You can adjust the position of machining point by Backward/Forward option.

 Lift Up: In the Stop state, the Z axis will lift up, and the A and B axes will return origin without

changing the nozzle's position in the horizontal plane.

 Simulate: This process can be done independently, during which the machining sequence and

procedure can be checked.

5.2.4 Machining

Figure 5-7 Machining

 Start: Start machining.

 Pause: Pause current machining.

 Resume: Resume suspended machining. Pierce action will be executed if there is pierce technique

preset for the graphics.

 Stop: Stop current machining..

 Cut selected only: Only selected graphics will be processed if this option is enabled. It will not start

machining if no graphics are selected.
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5.2.5 Parameters

The Parameters Settings panel is on the left of the machining control, where you can modify

settings for Burst, Jog, Cutting, and so on.

 Burst Settings

Figure 5-8 Burst settings

 Burst peak power: Peak power of burst laser.

 Burst duty cycle: The duty cycle of burst laser signal.

 Burst frequency: The frequency of burst laser signal.

 Gas pressure: Gas pressure when bursting.

 Focus: Focus position when bursting.

 Apply Parameters: Write in the parameter by this option after changing Focus and Beam.

 Jog Settings

Figure 5-9 Jog settings

 XY jog high speed: X/Y Jog/Step speed when it is in H status.

 XY jog medium speed: X/Y Jog/Step speed when it is inM status.
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 XY jog low speed: X/Y Jog/Step speed when it is in L status.

 XY Step length: Step distance of X/Y when the Step option is checked.

 ABC jog high speed: A/B/C Jog/Step speed when it is in H status.

 ABC low speed: A/B/C Jog/Step speed when it is in L status.

 ABC step length: Step angle of A/B/C when the Step option is checked.

 Forward/Stepback Settings:

Figure 5-10 Forward/stepback settings

 Frame speed: Sets the Frame speed.

 Distance: Sets the Forward and Stepback distance. In a Pause state, the Forward and Stepback

can be used to locate to the desired position.

 Max speed: Sets max speed for Forward/Backward.

 Cutting Resume Settings:

Figure 5-11 Cutting resume settings

 Stepback at resume: If checked, the cutting head will move backward for specific distance when

you click Resume.

 Pierce at resume: If checked, the cutting head will pierce before actual cutting when you click

Resume.
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 Other Options:

Figure 5-12 Other options

 XY Soft limit: If checked, soft limit for XY axes will be enabled.

 Co-edged pierce: If checked, pierce at each co-edged toolpath of straight cut.

 ABC Soft Limit: If checked, soft limit for ABC axes will be enabled.

 Find edge before production: Find edge automatically before actual cutting.

 Mark corner before cutting: If checked, the machine will mark corners before actual processing

to ensure all to-be-cut graphics are exactly within plate, avoiding the risk caused by operator

observing the framing by walking on the plate.

 Simu Speed: Simulation speed can be changed.
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Chapter 6 Cutting File

6.1 About

6.1.1 About Interface

The about interface provides detailed system information including the program’s version number,

release date, control card type, height controller type, laser type and license expiration, etc.

Figure 6-1 About
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6.1.2 Parameter Backup

FACut offers parameter backup and restoration functionality. Click About → Parameter Backup to

generate a backup file (*.cfgpkg) at the specified path. Double-click the backup file or open it through the

platform configuration tool (FACutConfig), and the parameter restoration dialog will pop up. Select the

file list to restore and click Restore to restore the machine parameters.

Figure 6-2 Parameter restore

6.1.3 Save Troubleshoot File

This function saves the current drawing, logs, alarms, and other information as a compressed file,

making it easier to collect and send all information upon a machine failure.

Figure 6-3 Save troubleshoot file
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It supports selecting only the modules related to the fault and customizing the number of days of

information to save. After clicking Save Troubleshoot File, the file save window will pop up, allowing

you to specify the location to save the fault information package.

If a fault occurs and you cannot click Save Troubleshoot File within the software, you can also

select by Windows Start Menu → FACut → Fault Information Packaging Tool. Both methods serve

the same function.

6.1.4 NC Log

This module displays motion-related information from the machine and allows you to Save the

current NC log or Open existing NC log files.

Figure 6-4 NC log
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6.1.5 Maintenance

In FACutConfig, you can configure scheduled maintenance tasks in the corresponding module. If the

software is launched during a scheduled maintenance window, the system will issue a warning or alarm

notification.

In the Maintenance window, the operator must enter Maintainer and Maintenance Remarks, then

click Start Maintain to dismiss the alert. The window also allows you to view the status of each

maintenance item and filter maintenance records by various conditions.

Figure 6-5 Maintenance

6.2 Task

Click the Task drop-down menu to load a cutting task or save the current cutting task. The task file

(*. fj) from FACut is capable to save the drawings and breakpoint information. When the processing is

interrupted unexpectedly, the current task can be saved and loaded when the production is resumed. On

the premise that the plate has no relative motion to the machine, the processing can be resumed from the

breakpoint.

6.3 RayBox

FACut supports RayBox usage, which can be used for operations such as importing drawing tasks

and remote control.
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Chapter 7 Mechanical Settings

7.1 Return Origin

When the machine is installed for the first time or the mechanical coordinate system deviates due to

abnormal reasons, you can click Return Origin on the top toolbar to reset the machine coordinate system.

FACut supports single-axis return origin, selected-axis return origin, and full-axis return origin

operations.

Figure 7-1 Return origin

When the option Use Z Phase Signal is enabled in FACutConfig, the Return Origin interface will

display options related to Initialize gantry when return origin and Initialize dual-drive gantry (available

in the Expert mode).
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7.2 Calibrate

Capacitance calibration and pressure calibration help ensure optimal cutting performance by

stabilizing height control and gas delivery during processing.

7.2.1 Capacitance Calibration

Ensure that the nozzle is tightly secured and the cutting head is above a plate surface. Jog to lower

the cutting head close to the plate, then click Start Calibrate. Once calibration is complete, confirm that

both smoothness and stability indicators display Excellent.

Figure 7-2 Capacitance calibration

After a successful calibration, you can move the cutting head to any location on the plate and click

Quick Calibrate (Current point) to perform a localized calibration.

Caution: The capacitance calibration needs to be re-executed after the nozzle is replaced or a

capacitance alarm occurs.
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7.2.2 Pressure Calibration

Select nozzle and gas type and calibrate the gas pressure.

Figure 7-3 Pressure calibration

Caution: When nozzles of different diameters are used, re-executed Pressure Calibration.

7.2.3 Quick Calibrate (fixed)

Before using quick calibration, capacitance calibration must be completed.

You can jog the cutting head within the interface to read its current coordinates, or manually set a

fixed point. After moving the head, click Return Fixed Point to move it back to the defined position.

Click Fixed Point to perform a one-click capacitance calibration at that location.

Figure 7-4 Quick calibrate (fixed)



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 92

Chapter 8 Software Settings

8.1 Global Parameter

Global Parameter defines machine-wide settings such as acceleration and general machining

options.

8.1.1 Cutting Params

Figure 8-1 Cutting parameters
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Details of the explanation of each parameter can be found in the following table:

Table 8-1 Cutting Params: User Settings

Name Description

Cut finished, return to Selection includes User Zero Point/Cutting End Pos/Marks.

Check breakpoints

before cutting

If enabled, the system checks for breakpoints before restart cutting after a stop.

Auto tech check

before cutting

If enabled, the system checks graphic techniques before each machining session.

Show time estimation If enabled, the estimated completion time will be displayed in the upper-left

corner of the CAD panel during machining.

Press and hold Fn +

Forward/Backward

to keep going

forward/backward

If enabled, holding Fn + Forward/Backward on the WKB wireless remoter will

move the cutting head continuously along the original path.

Table 8-2 Cutting Params: Travel and Lift Strategy

Name Description

Frog leap lift If enabled, the cutting head lifts as frog leap during travel.

Frog leap height Lift to the set height before executing frog leap.

Max lift height Max lift height of frog leap.

Max frog land distance The distance at which frog land begins.

Short travel no lift If enabled, the head skips lifting when the next segment is within a specified

short distance.

Protected lift Enables anti-collision logic during all lifting motions. See FACut - Protected

Lift.

Table 8-3 Cutting Params: Bevel and Swing Settings

Name Description

Corner transition Selection includes Direct Corner Transition/Normal-based Optimization.

One path cutting for

bevel outer toolpaths

When enabled, continuous cutting for connected bevel contours.

https://drive.weixin.qq.com/s?k=AJEAqwcIAAcsg8loAu
https://drive.weixin.qq.com/s?k=AJEAqwcIAAcsg8loAu
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Name Description

Continuous cut without

straighten

Enables efficiency boost by minimizing swing-back motions between tilted

piercing segments.

Special bevel

continuity optimization

Optimizes corners further when Optimize Orthogonal Bevel is enabled.

Optimize Orthogonal

Bevel

Improves continuity when cutting rounded rectangle V/Y/X/K bevels.

Table 8-4 Cutting Params: Detect Cutting

Name Description

Detect Cutting Pre-runs the path to compensate for plate deformation, improving accuracy.

Use custom speed Sets the speed of the detection, recommended to be limited to 80 mm/s or lower.

Use gas Sets gas type and pressure for detection.

Realtime Plate

Detection

When enabled, the detection before cutting is omitted for fixed-stance bevels,

while still maintaining compensation effect.

Sampling precision Located in Advanced: Controls sampling density. Precision first = tighter

tracking; Stability first = sparse tracking. Stability first prevents untimely Z-axis

following response due to over-sampling when the plate deformation is large.

Detect Height Located in Advanced: Sets head height (1 ~ 5 mm) during detection.

Vibration Suppression Sets the parameters for Vibration Suppress during the detection, and higher

Sample Filtering Lv improves the suppression effect.

Compensate bevel

degree by plate

detection

Detect Cutting fits a new plate surface by collecting the plate capacitance where

the machining track locates. If enabled, the calculated normal vector of the

surface is also compensated in the processing commands.

Table 8-5 Cutting Params: Advanced

Name Description

Pierce defilm settings Set the cutting sequence and grouping sequence of pierce and defilm.

One-path marking Enables one-pass marking (ineffective with external devices). Supports

max stroke distance.

Non-beveled path use pure

follow mode

Enables pure follow mode (same as HypCut) for height controller during

straight cuts rather than interpolated follow.
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8.1.2 Motion Control Params

Figure 8-2 Motion control parameters

Details of the explanation of each parameter can be found in the following table:

Table 8-6 Motion Control Params: Travel Parameters

Name Description

X/Y/A/B Travel speed Set max travel speed for the X/Y/A/B axis.

X/Y/A/B Max travel acc Set max travel acceleration for the X/Y/A/B axis.

Low-pass filter Set the travel low pass filtering frequency. This parameter is related to the

mechanical performance, and the default is 5 Hz.
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Table 8-7 Motion Control Params: Path Interpolation Parameter

Name Description

X/Y/Z/A/B Max constraint

speed

Limit the speed of single-axis machining.

X/Y/Z/A/B Max cutting acc Limit the acceleration of single-axis machining.

X/Y/Z/A/B cutting low-pass

filter

The low-pass filtering frequency for machining, and the default is 5 Hz.

The better the performance of the machine, the higher acceleration and

lower pass filtering allowed.

Optimize Corner Speed
When checked, it optimizes the speed reduction when machining

rounded corners (for straight cuts only).

Control corner precision

Determines corner rounding fidelity. Lower values = sharper corners but

slower. The value can be adjusted to make a trade-off between corner

cutting speed and accuracy. This parameter is currently valid for straight

cuts only.

Fly cut overcut Defines early laser-on and late laser-off distances to ensure part drop-off.

Small circle time constant
Minimum time for small arc cuts. Higher values = better precision,

slower speed.

Table 8-8 Motion Control Params: System Delay

Name Description

System delay
The current system delay is measured by Measure Delay to to adjust

laser-on/off timing during fly-cutting.

Measure delay
Uses EtherCAT bus to calculate and compensate for latency, ensuring

multi-axis sync and cut accuracy.
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8.1.3 User settings

Figure 8-3 User settings

Details of the explanation of each parameter can be found in the following table:

Table 8-9 User Settings: Common

Name Description

Speed unit
You can change the speed unit in Global Parameter. Optional: mm/s, m/s,

m/min, mm/min, in/min, in/s.

Language

FACut supports both simplified Chinese and English. Add other language

packages to the installation directory, then the corresponding language will

be available. Restart the software to complete the language change.

8.1.4 Gas Params

Figure 8-4 Gas parameters
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Details of the explanation of each parameter can be found in the following table:

Table 8-10 Gas Parameters

Name Description

Gas/O2/N2 on delay Delay required to stabilize gas pressure after opening the gas circuit.

Gas switch delay
Time required to purge the previous gas before stabilizing the new gas at the

cutting head.

Cooling delay Duration of gas cooling at cooling points.

Gas off delay
Delay before shutting off the gas after cutting, reducing unnecessary gas

activation for short-distance movements.

First gas on delay Delay before the first gas blow at the start of processing.

Gas on after swing
When the cutting head stops rotating, it will turn off the laser and blow

according to the set time.

8.2 PLC

FACut supports setting up PLCs for alarm handling and production processes, including custom PLC

processes.

Figure 8-5 Manage PLC

After configuring a custom process in the PLC module, click the drop-down menu to select and

execute the desired custom PLC.
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Chapter 9 Auxiliary

9.1 Find Edge

FACut supports several find-edge methods, such as Auto Find Edge, 2-point Find Edge, Manual

Find Edge, and Circle Center. Click the Find Edge drop-down under the Production toolbar to choose

the most suitable method based on actual conditions to determine the plate placement. The edge finding

result will be displayed in the upper-right corner of the CAD panel.

9.1.1 Auto Find Edge

Click Find Edge on the top toolbar to enter Auto Find Edge interface, as shown in the figure:

Figure 9-1 Auto find edge

 Auto identify plate size: When checked, the system automatically identifies the plate size, using the

maximum drawing size by default. If unchecked, you should enter the actual plate size manually.

Caution: Ensure manually entered values are slightly smaller than the actual plate size to avoid

nozzle crashes caused by mismatches.

 Margin: The edge detection point is typically set outside the plate. A positive value shifts the point
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inward (into the plate); a negative value shifts it outward (beyond the plate). Setting an margin helps

prevent cutting head vibration due to capacitance fluctuations near the edge. If edge margin has

already been configured in the nesting stage, set this value to 0.

 Strategy: You can select between 3-point Quick Find Edge and 6-point Slat-Avoid Find Edge;

Among them, 6-point slat -avoid find edge is suitable for thin plates to avoid the interference caused

by rack tips. Advanced settings allow adjusting the spacing between the two probe points on the

same edge.

Notice: Find edge parameters will affect the accuracy of edge-finding, so it is suggested to use

the initial values: Find edge speed 100 mm/s; Find edge follow height 4 mm. For improved accuracy

on long sides, increase the spacing between probe points.

 Start from preset position: Each edge find starts from a user-defined fixed point. You can jog the

cutting head to the desired start point and save it. Ensure this point is inside the plate.

 Start from current position: Starts from wherever the cutting head currently is. Make sure the cutting

head is above the plate before starting.

If the Find edge before production option is enabled in parameter settings, the system performs a

capacitance edge finding before dry-run or machining based on the graphic zero point. In this case, select

Start from preset position and ensure the starting point is properly configured.

Caution: Before edge finding, please Return Origin to reset machine coordinates and ensure

that the cutting head is capable of following properly. The inclination angle of the plate should not

exceed 10 degrees.

9.1.2 2-Point Find Edge

This is a simplified strategy within automatic edge finding, shown as a separate option because it

does not set the program zero point. Hence, it is not applicable for Find edge before production. Its

parameters are identical to Auto find edge, except that the point selection strategy only supports 2-point

Quick Find Edge.
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9.1.3 Manual Find Edge

Figure 9-2 Manual find edge

Manually move the cutting head to the edge of the plate, and record the coordinates of two different

points on each edge of the plate respectively, and the system will automatically calculate the tilt angle of

the plate. The longer the distance between two points is, the more precise the angle calculated is.

9.1.4 Circle Center

Figure 9-3 Circle center

This method is used exclusively for circular plates. After centering, the program zero point is placed

at the center of the circular plate. Thus, ensure the zero ref of the drawing is set to Center.

Caution: Before starting, make sure the cutting head is above a circular plate.
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9.2 Quick Cut Off

9.2.1 Quick Cut Off

Click Quick Cut Off from the Production toolbar or from its drop-down menu to enter the Quick Cut

Off interface. This function is mainly used for quickly cutting off remnant materials along the X or Y axis.

The interface is as shown in the figure:

Figure 9-4 Quick cut off

 Cut off direction: Select cutting starting point and cutting direction in four options listed.

 After cutoff, return: Choose to return to Start Point or stay at End Point after cut off.

 Plate type: Select a specific plate type according to actual situation.

 Bevel angle: FACut supports beveled quick cut off. Set the bevel angle to perform cutting.
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 Cutting head swing: Choose tilt direction of the cutting head during the cutting.

 Enable find edge angle cut off: When enabled, the cutting direction is adjusted based on edge-finding

results.

Notice: The default cutting technique for quick cut off is the layer 1 (green).

9.2.2 Cut Off Guiding

Supports flexible definition of cutoff lines by selecting points, helping save material more efficiently.

Figure 9-5 Cut off guiding
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9.3 Nozzle Correction

The swing length and zero focus of the cutting head will be changed after replacing the nozzle of

different lengths. Therefore, nozzle parameters should be adjusted accordingly after each nozzle

replacement.

Upon opening the nozzle parameter adjustment interface, the Select nozzle defaults to the last

selected one. You can click the drop-down arrow to switch nozzles or click the + icon to enter the nozzle

abbreviation and name to add a new one. The - button allows you to remove the currently selected nozzle

from the nozzle library. Click Confirm at the top of the interface to write the Current swing length and

Current focus offset of the selected nozzle into the current values.

Notice: Each time swing length or focus offset is written, both the current values and the

selected nozzle’s stored values will be updated. The actual processing is based on the Current swing

length and Current focus offset.

9.3.1 Swing Correction

Figure 9-6 Swing correction
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Swing Correction must be performed after Vision Calibration. Ensure there is material under the

cutting head, sufficient axis travel, and no mechanical interference.

After setting the technique for marking, click Start Mark, the cutting head will tilt to the set angle,

and cut two marking lines along the set direction. Observe the marking lines along the cutting head

motion direction, measure the X Distance between them, and enter the results in Mark result 1 or Mark

result 2 according to the relative position of the marking lines. Click Confirm to write the data to the

current swing length.

In addition, you can click Unlock to enter the Swing length directly and click Save to set it as the

current swing length.

Notice: After marking parameters are modified, if you use WKB to Start marking, click Save

Params first to ensure the updated process parameters take effect.

9.3.2 Focus Correction

Figure 9-7 Focus correction

The focus testing allows measuring the actual focal position under the current conditions and writing
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the corresponding calibration value.

Step 1 Adjust focus range and spacing. A smaller spacing improves accuracy. Repeat testing if needed.

Keep default values for marking line parameters.

Step 2 Click Generate File and Correct Technique, enter the marking technique in the pop-up window,

save the settings, and then click Execute.

Step 3 Observe the finished workpiece and check the focus value on the right corresponding to the

thinnest line. For example, the focus on the right corresponding to the thinnest horizontal line in the

following figure is -1, which indicates that the zero focus is at -1. Enter -1 to the Focus calibration

box, and click Confirm to write the focus offset into the current value.

Figure 9-8 Zero focus

Figure 9-9 Focus calibration

Notice:

1. Focus should return origin before cutting.
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2. A 1 mm thick stainless steel plate is recommended.

3. Suggested following height: 1 mm.

4. Use zero focus offset in cutting.

5. Pay attention to the positive and negative directions of the feeler gauge to avoid incorrect input

of positive and negative values.
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9.4 Other

9.4.1 Tape Shot

Tape shot is mainly used to detect whether the lens/windows in the cutting head is contaminated.

Step 1 Lay the photo paper flat on a 200 × 300 mm plate and secure its four corners with masking tape

to keep it smooth.

Step 2 Place the plate with photo paper in the hopper.

Step 3 Turn on the aiming red light, move the cutting head or fine-tune the paper’s position to ensure

the red light is centered on the photographic paper. Ensure the cutting head is positioned in the

middle of the rack to prevent the beam from being obstructed.

Step 4 Replace the nozzle with a single-layer nozzle larger than 3.0 mm in diameter and set the focus to

zero focus. Select Tape Shot in the drop-down list of Other, and enter the following parameters:

 Peak power: Around 10,000 W (for lasers below 10,000 W, input the maximum power)

 Duty cycle: 100%

 Pulse freq: 5000 Hz

 Laser On: 25 ms
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Activate the laser to perform the test.

Step 5 After the test, evaluate the paper for abnormalities to determine potential contamination or

optical misalignment.

9.4.2 Stations Management

FACut supports multi-task processing. You can configure either 1-Pallet - N Station or 1-Pallet - 1

Station with pallet changer to manage automated part cutting and material handling across multiple

workstations.

For details, refer to FACut - Multi-task.

https://drive.weixin.qq.com/s?k=AJEAqwcIAAcwHldBZF
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9.4.3 Mark Corner

Figure 9-10 Mark corner

Mark Corner, similar to Frame, both can be used to determine whether the to-be-machined figure is

within the plate. It will activate laser on the four corners of the figure frame and make four L-shaped

corner marks on the plate. ClickMark Corner Test will perform the mark corner action.

9.4.4 Clean Nozzle

After enabling Nozzle Cleaning under FACutConfig → Planar NC System → Advanced Config,

the Clean Nozzle function will appear under Other in the FACut Production toolbar. This function needs

nozzle to work with brush and open gas to to clean up the metal slag inside the nozzle.

Figure 9-11 Automatic clean nozzle

You can configure basic parameters in the Clean Nozzle window, and click Adjust Params to open

the advanced settings interface, where you can configure motion parameters for the nozzle cleaning

process. There are three kinds of Clean path: Line, Circle and Wavy line. In the preview diagram, the

green dot represents the starting point while the red dot represents the ending point. Ensure all movement
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paths stay within the machine’s travel limits.

Figure 9-12 Auto clean nozzle advanced settings

9.4.5 Border Contour

Figure 9-13 Border contour

The Border Contour function generates one or more boundary lines around the maximum outer

contour of a part. The function include creating and clearing the border contour.

 Create Border Contour: Creates border contours based on the parts. The larger the part spacing, the

larger the area covered by the border contour.

 Clear Border Contour: Deletes all existing border contours from the current drawing.
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Chapter 10 Tools

10.1 Debug

10.1.1 IO Board

In the IO board monitoring interface, select the board number to be tested in the top-left to perform

operations such as toggling output ports on/off, monitoring input port status, simulating input tests,

debugging PWM and DA signals, and monitoring AD sampling results.

Figure 10-1 IO board

After checking Test Mode, you can manually test the input and output ports without being affected

by the real-time refreshing thread.
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10.1.2 Height Controller Monitor

The monitoring page displays real-time capacitance, capacitance curves, and capacitance

temperature drift of the height controller.

Figure 10-2 Height controller monitor interface

On the Calibrate page, you’re allowed to finish capacitance calibration, and adjust follow parameters

and interpolation level.

Step 1 Ensure that the nozzle is tightly secured and the cutting head is above a plate surface. Jog to

lower the cutting head close to the plate, then click Capacitance Calibration. Once calibration is

complete, confirm that both smoothness and stability indicators display Excellent.

Step 2 After calibration, perform Auto Adjust and Interpolated Auto Adjust to optimize the Follow

Level (LV) and Interpolated Follow Level (ItpLV).

Figure 10-3 Height controller calibration
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The Parameters page is used to adjust the parameters of the height controller. Click Unlock

Parameter to modify the parameters and click Write Parameter to save the changes and make them

effective.

Figure 10-4 Height controller parameter

The parameters are described in the following table:

Table 10-1 Height Controller Parameter

Name Description

Travel/Cutting/Piercing

Hit-Plate

Alarm Delay

When the system stops or in a state of travel/cutting/piercing, if a collision

persists longer than the set value, the Z-axis retracts and alarms. A value of 0

disables this alarm.

Follow Error

Maximum allowable following error. After the cutting head follows in place,

once the following error exceeds the limit as the cutting head moves out of the

plate boundary or the plate vibration, a follow error alarm will be triggered.

Follow Error Delay

This value determines how long follow-up errors can occur before triggering

the alarm. The larger the value, the longer the system allows for follow errors,

and the better the ability to filter out interference.

Local Capacitance Drop
An alarm will be triggered when the local capacitance decreases beyond the

set value.

Auto Lift on Hit-Plate

Alarm

If on, the cutting head will lift up automatically once there is a hit-plate alarm.

If disabled, the cutting head will remain in place after the alarm is triggered.

Realtime Calibration
Enabling this function helps avoid issues caused by temperature drift, which

can affect cutting quality.

Calibration Range Sampling range of Capacitance Calibration.

Max Follow Distance Max follow height allowed by the height controller. If the follower is above
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Name Description

this height and Follow is triggered, the height controller will lower to the plate

surface and then move upwards to theMax Follow Distance.

Vibration Suppression

It is capable of suppressing the vibration caused by the cutting airflow on the

plate with weak structural rigidity so as to reduce the cross-section wavy lines.

It is also effective in suppressing vibrations caused by gas and slags.

Suppression Time

This parameter sets the strength of the vibration suppression function. A

higher value will result in more noticeable vibration suppression but may

reduce the responsiveness of the height controller. The default value is 20 ms,

and the recommended range is 5 ~ 50 ms.

Follow Level

The following gain level is from 1 ~ 30, with a default value of 17. A higher

level brings less average error and quicker follow motion, also stronger follow

capability on the tilted plate. However, self-oscillation will be caused by a

too-high follow level. You can automatically acquire a proper level by Auto

Adjust.

Reset and Go Zero Ref Whether to go to Zero Ref of the Z-axis after Return Origin.

Zero Ref Zero reference for Z-axis.

Enable Soft Limit Whether to enable soft limit protection for the height controller.

Travel Speed Height controller travel speed.

Travel Acceleration The height controller travels acceleration.

Jog High Speed Set the jogging speed for high-speed movement.

Jog Low Speed Set the jogging speed for low-speed movement.

Interpolation Max

Up/Down

Under the interpolation algorithm, the following algorithm affects the response

speed of distance.

Interpolation Follow

Level

The higher the interpolation follow level, the more sensitive the following

algorithm will be to capacitance. This results in better follow accuracy.
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10.1.3 Motion Control Kernel Monitor

Figure 10-5 Motion control kernel monitor - motion axis

Motion control monitoring tool, including motion axes monitoring and kernel status monitoring.

Table 10-2 Motion Control Monitoring Parameters

Name Description

Axis The configured physical axis number.

Encoder Feedback The encoder feedback value of servo, in Pulse.

Command Position The command position, in Pulse.

Machine Coordinates The system command position, in mm or rad.

Motion Speed Real-time feedback speed of current servo.

Servo Raw Feedback Record the feedback position of the servo motor.

Servo Alarm Current servo alarm.

Negative/Positive Limit Switch Current negative/positive hard limit input state.

Origin Switch Current origin signal input state.

Negative/Positive Soft Limit Current negative/positive soft limit input state.

Pitch Compensation
Check whether Pitch Compensation is enabled, only available for the

X and Y axes.

Servo Enable The servo enables status. Clicking to turn the servo enable on or off.
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Name Description

Pulsing
In the system stop state, allows sending specified pulses for testing

purposes.

Set Current Position as Origin
This option is only available for A and B axes. You’re allowed to set

the current position as the origin for the A or B axis.

Clear Multi-turn Encoder Alarm

It is capable of clearing the A/B axis alarm of Yaskawa A810 (absolute

encoder), this option only appears on the page of the corresponding

axis when the alarm exists.

Set Machine Coordinate 0 Reset X/Y/Z mechanical coordinates to 0.

On the motion axis monitoring page, you can check the servo enable state, alarm state, hard/soft

limit state, origin switch state, pitch compensation state, physical axis commanded position, feedback

position, mechanical coordinates, and motion speed for each servo axis. You can also enabling/disabling

the servo, sending test pulses, clearing coordinates, and clearing dual-drive alarms.

Figure 10-6 Motion control kernel monitor - kernel state

On the kernel state monitoring page, more in-depth kernel-level information is available, such as

mechanical coordinates, program/user coordinates, buffer count, and G-code instruction data. Due to the

complexity of these concepts, detailed explanations are omitted here.
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10.1.4 Vision Calibration

Vision calibration is a key feature of FACut bevel cutting software. It uses camera-based detection to

automatically correct the simulated parameters of the swing axis and cutting head, ensuring high cutting

accuracy.

Figure 10-7 Vision calibration

For details, refer to FACut - Vision Calibration.

10.1.5 Vision Calibration Parameter Read/Write

When both FACut and FACut-H are installed on the same device and the mechanical structure

remains unchanged, previously saved vision calibration data can be reused after switching between the

software.

For example, when using FACut-H on a device for the first time, you can reuse the vision calibration

data previously generated with FACut.

Figure 10-8 Vision calibration results read/write

https://drive.weixin.qq.com/s?k=AJEAqwcIAAcBGxfvgF
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Warning:

1. If the cutting head experiences a collision, you must re-execute vision calibration.

2. Even with identical mechanical parameters, do NOT reuse vision calibration results from other

machines via the Vision Calibration Parameter Read/Write feature.

10.1.6 Capacitance Zero Point Calibration

This function allows for quick correction of axis zero points, assuming vision calibration and swing

arm length compensation have been properly completed. Ensure axis initialization is completed with

correct zero axis before performing zero point calibration.

Figure 10-9 Capacitance zero point calibration
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10.2 ErrorAnalysis

10.2.1 Measure Error

Error measurement is used to compare actual multi-axis motion trajectories with the commanded

paths, assisting in tuning axis response behavior. There are three types of test trajectories: XY Axis Circle

Test, Draft Circle Test(A axis, B axis and AB axes), and Bevel Line Mark, as shown in the figure:

Figure 10-10 Measure error

 Circle Test Parameters:

 Start point: 0° at the right, 90° at the top, based on polar coordinates.

 Draft Angle: When the angle is positive, the cutting head deviates to the left along the track;

when the angle is negative, the cutting head deviates to the right.

Notice: The left/right deviation of the cutting head refers to the rotation of the cutting head arm

while the nozzle position remains unchanged.

 Bevel Line Mark Params:

 Line direction: From left to right is 0 degree, from bottom to top is 90 degrees, defined by polar

coordinates.

 Start/end point bevel: The swing angle at the start and end point.

 Start/end point phase: When the phase is 0 degree, it will swing along a straight line; if the

phase is 90 degrees, it will rotate 90 degrees counterclockwise in line direction and then start

swinging.
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Figure 10-11 Measure error

The typical workflow is to run XY axis circle test → A axis draft circle test → B axis draft circle

test→ AB draft circle test. After finishing the settings, click Create Path to generate a green command

path in the test interface. Click Start Test, and each axis will execute Dry Run according to the commands

to generate a blue feedback path.

If there is a noticeable discrepancy between the commanded trajectory and feedback trajectory in

certain quadrants of the circle, switch to the Servo Debug interface and click Measure Delay to measure

the system delay of the X/Y/Z/A/B axes, typically adjusting based on the Z-axis. You can make the servo

delay of each axis consistent through manual or automatic adjustment:

Figure 10-12 Measure delay
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 Manual Adjust: If the X/Y/A/B delay is too small, increase the delay (e.g., decrease tracking gain for

Yaskawa, increase filter time for Hiwin, decrease rigidity for Mitsubishi). Conversely, reduce the

delay to make the delays of each axis approximately the same (usually, axis delays should not exceed

5000 μs).

 Auto Adjust: In the Measure Delay interface, click Auto Adjust, set the target delay time and

vibration protection level (usually default 4), and click Delay Adjustment. The system will

automatically adjust each axis' delay to the target value.

Once the servo delays of all axes are consistent, the commanded and feedback trajectories should

largely overlap. The result of the A/B axis draft circle test should be controlled within 0.05 mm, and the

result of the draft circle test should be controlled within 0.07 mm.

If there is still a large error in the extraction circle after adjusting the servo delay, click Error

Amplification(10x) in the View drop-down menu to enlarge the tested trajectory by 10 times and observe

the source of error. At this point, the error typically appears as:

 The feedback trajectory is generally contracted compared to the commanded trajectory.

 There is an obvious inflexion point.

The below shows the corresponding solutions:

 Path shrinkage is due to excessive overall servo delay, it is necessary to reduce the delay of each axis

within the mechanic design allowance.

Inflexion point is often related to friction, you can try to add friction compensation to the

corresponding axis.



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 123

10.2.2 Trajectory Capture

This feature monitors commanded and feedback trajectories of processed parts to help troubleshoot

issues. You can toggle curve visibility as needed. During processing, raw trajectory is shown first,

followed by commanded and feedback curves after execution.

Figure 10-13 Trajectory capture
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10.2.3 Swing Precision Calibration

This function verifies the accuracy of the swing model determined by vision calibration and swing

correction.

Figure 10-14 Swing precision calibration

Set appropriate marking parameters and click Start Mark. Observe whether the center of the vertical

marking cross aligns with the center of the tilted marking cross.

If there is a significant deviation, it indicates a large error in the swing model. In this case, check for

issues in the machine’s mechanical structure, vision calibration, and swing correction.
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10.3 Tools

10.3.1 Real-time Curve Monitoring

Real-time monitoring can accurately sample the command position, command speed, feedback

position, feedback speed, feedback torque, command position deviation, dual-drive position error, buffer

number and height controller position. You can select any four of the above to monitor for at least 5

seconds, at most 20 minutes to check their signals and draw corresponding curves.

Figure 10-15 Real-time curve monitoring

By default, there will be four signal curves shown, which can be selected as needed by clicking

Select Signal at the bottom.

Check the box under Enable to turn on or off specific signal monitors or only monitor specified

curves in the designated span.

You can zoom in or out the vertical axis by scrolling the mouse wheel, and check the horizontal axis

by right-clicking the specified span and dragging it to the right. Hold down the right mouse button and

drag towards the left can restore the curves to the appropriate window.

Hold down the left mouse button to translate the curves. Click the left mouse button to display all

curves in the position designated by the mouse with a white label, and click the right mouse button to

display all curves in the position designated by the mouse with a black label.
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10.3.2 BLT Cutting Head Diagnosis

The interface provides information and debugging functions related to the BLT series cutting heads.

It helps to monitor the sensor parameters as well as the focus velocity curve and also allows performing

jog testing for the focus motor.

Figure 10-16 BLT cutting head diagnosis
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10.3.3 External Device Marking Calibration

When checked Use external device marking on the Advanced Config page of FACutConfig and

correctly configured the marking output, there will be a External device marking calibration option in

the drop-down menu of Tools. The purpose of this calibration is to determine the relative position

between the marking device and the cutting head nozzle.

Figure 10-17 External device marking calibration

Calibration steps:

Step 1 Adjust the installation position of the marking device to avoid interference during swing cutting.

Typically ensures no collision occurs when cutting a 45° draft circle.

Step 2 Adjust the cutting head pose to place the marking device at the correct height. Click Powder

Spraying and jog the cutting head while observing the marking trace to adjust the position. After an

appropriate marking track is achieved, click the Powder Spraying button again to stop the output.

Only when Powder Spraying is active will the system record the current swing pose and XY

coordinates.

Step 3 Click on Lift Up to return the cutting head to the vertical position. Do not move XY axes during

this process.

Step 4 Jog the cutting head to the end of the powder trace (where the powder device previously locates),
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click Follow, and fine-tune the position with the aiming red light until it aligns with the powder

endpoint. Click Save to exit the calibration interface. If there’s still position deviation after actual

marking, re-enter the calibration interface to manually edit and save the calibration result.

Once calibration is complete, assign the marking path to the First layer. In the technique settings

interface, there will be a option named Use external device marking. When enabled, there will be a new

layer named External Device Marking, and the cutting head will maintain fixed height and posture as it

does for calibration during this operation.

When marking with external device, supported parameters in the corresponding layer are as follows:

 Cut speed: Corresponds to powder spraying speed.

 Dwell time: Delay before spraying to allow gas mixing.

 Laser off delay: Delay after spraying to prevent residue during travel.

Figure 10-18 Technique settings for external device marking layer

Besides, if Short travel no lift and Short travel no follow for external device marking are enabled,

with the corresponding distances set, then the cutting head will stay at the height it finishes cutting and

travel to the next start point within the set distance.

Notice:

1. When both no lift and no follow for short distances are enabled, the cutting head will maintain

its height during travel. Risk of head collision increases if the sheet surface is uneven.

2. To enable the Short travel no follow for external device marking option, go to FACutconfig

→ Planar NC System → Advanced Config → Use external device marking, and uncheck

Enable telescopic device.



FACut Plane Bevel Laser Cutting Control User Manual

www.bochu.com 129

10.3.4 Common Axis Debug

After setting common axes in FACutConfig, it can be tested in this interface by jogging and

observing motion behavior.

Figure 10-19 Common axis debug

10.3.5 Yp Debug

Once the Yp follow-up axis is configured, this interface enables debugging and motion verification

for the Yp axis.

Figure 10-20 Yp debug

For a detailed explanation of the Yp follow-up axis, refer to FACut - Moving Enclosure.

https://drive.weixin.qq.com/s?k=AJEAqwcIAAcQgAZodd
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10.3.6 Manual Centering

FACut supports manual centering of circular plates by selecting three or more edge points on the

plate to construct a circle model and locate the center point accordingly.

Figure 10-21 Manual centering

10.3.7 Cycle Production

It can be used for loop machining of selected drawings, also for cutting demonstration in exhibitions

with laser off. You can add, delete, enable, and disable drawings in Cycle Production Settings, and set the

processing times and delay time after each processing. When the drawing for cycle production is enabled

and all settings are saved, the Start tab in the machining operation zone will change to Start L, and the

Dry Run button in the debugging operation zone will change to Dry Run L, which means the current

processing is in cycle production status.

Figure 10-22 Cycle production settings
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10.3.8 Cycle PLC

This function allows setting up long-duration, high-intensity loop test parameters to verify system

reliability and stability under continuous load.

Figure 10-23 Cycle test setup

10.3.9 Dry Run Settings

Set the dry run parameters. In bevel cutting, the Z-axis may move up and down due to cutting head

swing and corner transitions. Enabling Z-axis moves in dry runs improves simulation accuracy for bevel

cutting paths.

Figure 10-24 Dry run settings
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10.3.10 Time Estimation

This tool estimates the total processing time for a complete job, as well as the time required for

individual processing actions. It requires an accurate input of the plate surface’s corresponding Z-axis

position.

Figure 10-25 Time estimation

10.3.11 Bevel Size Calculator

It can calculate bevel parameters according to section type and section parameters. After selecting

the toolpath type(inner or outer), enter any 4 of these 5 parameters, and the rest constrained parameter

will be automatically calculated.

Figure 10-26 Bevel size calculator
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10.3.12 Laser Adjustment

This function assists in fine-tuning the XY installation accuracy using a laser interferometer,

improving overall processing stability and laser alignment precision.

Figure 10-27 Laser adjustment

10.3.13 Calibrate Fixture

Used to calibrate fixtures for dished head processing. By marking the actual installed position of the

fixture on the machine, it ensures alignment between the part and the programmed cutting path. Jog the

cutting head to locate four edge points of the fixture. The system uses these points as reference

coordinates to determine the fixture’s actual position.

Figure 10-28 Calibrate fixture
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10.3.14 Dished Head Zero Reference

Due to the curved surface of dished heads, the actual reference point during installation may differ

from the drawing’s coordinate system. By inputting the the dished head radius, the system calculates a

corresponding zero reference for the current part, ensuring fixture alignment with the processing path.

Figure 10-29 Dished head zero ref
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Chapter 11 Main Interface Status Bar

Click the gear icon at the bottom right corner of the main interface status bar to access the following

two sub-menus.

11.1 Set Modules

This function allows you to configure which modules are shown in the status bar. As the status bar

only supports five modules being displayed at a time, only the top five in the list will appear. To rearrange,

select a module and use the Up or Down buttons, then click Save to apply the changes.

Figure 11-1 Set modules

11.2 Production Count

This tool allows you to set a planned number of parts for processing. It automatically tracks the

number of completed parts and provides options for actions to take once the target is reached.

Figure 11-2 Production count
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